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Notes and Copyright

Download the latest version of this manual and other manuals for MOBOTIX products 
as PDF files from www.mobotix.com (Support > Manuals).

All rights reserved. MOBOTIX, MxControlCenter,and MxEasy are internationally pro-
tected trademarks of MOBOTIX AG. Microsoft, Windows and Windows Server are 
registered trademarks of Microsoft Corporation. Apple, the Apple logo, Macintosh, 
OS X and Bonjour are trademarks of Apple Inc. Linux is a trademark of Linus Torvalds. 
All other brand names mentioned herein may be trademarks or registered trademarks 
of the respective owners. Copyright © 1999-2010, Langmeil, Germany. Information 
subject to change without notice!

Further Information: 
www.mobotix.com
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1	 Introduction To MxEasy
Congratulations on your decision to select video security products from MOBOTIX. MOBOTIX 
offers you intelligent, high-resolution camera technology Made in Germany. The MxEasy 
software provides you with full control of your video security system.

1.1	 General Information

MOBOTIX are pleased to introduce you to the concepts and ideas behind MxEasy. In the 
following chapters we will guide you through the simple installation of the program onto 
your PC, Mac or Linux system, inform you how to integrate your MOBOTIX cameras into 
the system and even give you some examples of how MxEasy can give a professional 
Video Management System view of some SOHO (small office, home office) & business 
applications.

What Is MxEasy?

MxEasy allows you to quickly and efficiently configure and control a video security system 
of up to 16 MOBOTIX cameras, making it the perfect choice for all small and mid-sized 
surveillance systems. The program automatically finds all available MOBOTIX cameras 
(even in non-administered newtworks) and carries out the initial configuration for the 
selected cameras. You are not required to have an in-depth knowledge of network tech-
nology.

Main window

Menu bar

Image bar with 
camera/event 
windows

Tool Tips for MxEasy 
elements

Info bar 1

Info bar 2

Toolbars

Dynamic toolbar

Status bar
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Once the cameras are integrated into the system, you can use MxEasy to comfortably 
control the most important functions of the connected cameras. Virtual zooming, panning 
and tilting in the live image is just as easy as activating manual or scheduled recording 
times. This way, it makes no difference whether you choose to monitor the screen con-
stantly or just occasionally check up on the most recent events.

The video data recorded by the cameras can then be viewed and exported in different 
formats (e.g. MxPEG, AVI with different codecs) as required.

Easy Operation

To keep MxEasy simple and easy to use, camera operation has been streamlined to 
include only the absolute necessities. MxEasy is easy to understand and simple to use, so 
the risk of operating errors is minimal. The buttons are marked with easy-to-understand 
symbols and descriptions of each button (“tool tips”) are displayed automatically. All other 
control elements are intuitive to use. In addition, the user interface has been optimized 
for mobile devices and touch panels.

If any problems occur, you can quickly and easily undo any incorrect settings using the 
automatic configuration backup feature.

Security

MxEasy provides you with four different access levels (guest, user, owner, administra-
tor), allowing people with different levels of authorization to access the camera images. 
This makes it possible to install MxEasy on several computers at the same time without 
causing access-related conflicts. Optional HTTPS encryption (using certificates generated 
by the camera or created by the administrator) helps you to prevent unauthorized users 
from accessing MxEasy.

Operation Modes

The different operation modes allow for easily adjusting MxEasy to the current application 
scenario. The Switched Off Mode does not record anything, but still transmits the live 
images. The Alarm Planner Mode detects alarms and starts recording according to the 
times and the alarm sensors specified in the weekly schedule. The Alert Mode records 
the audio/video data of all cameras controlled by MxEasy.

In addition, you can trigger the Manual Alarm in case of an alarm, which records the 
audio/video data of all cameras for a specific time. The Privacy Mode is used to guarantee 
absolute confidentiality. For this purpose, MxEasy changes the passwords on all attached 
cameras and thus effectively prevents all attempts to access the cameras.

Why MxEasy And Not MxControlCenter?

MxEasy is the perfect choice for all small and mid-sized video security systems using 
cameras connected in a network. MxEasy has fewer functions than the professional 
video management software MxControlCenter, because, as its name implies, MxEasy 
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is specially developed for ease of use. All of the main features of the MOBOTIX software 
are available in MxEasy.

Note

When planning your MOBOTIX system, make sure to note that with MxEasy you can 
integrate and manage up to 16 cameras. For larger video security systems, we recom-
mend that you use MxControlCenter (www.mobotix.com under Support > 
Software Downloads > MxControlCenter).

1.2	 Sample Scenarios

The following examples are possible ways to use MxEasy. They contain information about 
the required components and setup for the individual scenarios:

•	 House with two cameras

•	 Gas Station with four cameras

•	 Hotel with nine cameras

The application scenario and the components required to set up the system will be described 
for each of the examples.

For more information on the individual components of a complete surveillance system, 
see Appendix B.1, System Components in the MOBOTIX product descriptions and the 
manuals of the individual camera models at www.mobotix.com.

For a brief overview of all important steps for installing and configuring this type of surveil-
lance system, see Section 1.3, “Setting Up A Video Surveillance System – Overview”. These 
steps are described in more detail in Chapters 3 to 5.

1.2.1	 House With Two Cameras

This scenario consists of two MOBOTIX cameras that guard the entrance and the rear of 
a house. When the homeowner is away for the weekend, these cameras use integrated 
video and infrared motion detectors to detect unwanted movements around the house. 
In the case of an alarm, the video sequences are recorded in the cameras. In addition, 
this triggers a call to the homeowner's cellular phone and sends the images to the hom-
eowner via e-mail.

MxEasy is the user interface in this example. Using this software, the user can conveniently 
and easily set up and operate their MOBOTIX cameras.

Required Components

•	 1 x MOBOTIX Q24M (entrance)

•	 1 x MOBOTIX D24M with L22 lens and Outdoor Wall Mount (rear of house)

http://www.mobotix.com
http://www.mobotix.com
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•	 2 x MOBOTIX NPA-PoE-Set

•	 Switch with at least four ports

•	 Network patch cables

•	 Computer installed with a Windows, Mac OS X or Linux operating system

•	 Configured DSL router registered with a VoIP provider (required for telephone and 
e-mail notification and external access via DynDNS)

1.2.2	 Gas Station With Four Cameras

In this scenario, a gas station is guarded using a MOBOTIX system. The video sequences 
are recorded in the cameras.

Two cameras record the events at the pumps, the camera in the shop records any unau-
thorized access, and the camera above the register records the entire cash register area.

The cameras are set up to record video and audio data at a continuous rate of 2 frames 
per second during business hours. This continuous recording is deactivated outside of 
the opening hours. If motion is detected (using a video motion window), the camera will 
record at a higher frame rate for a specified period of time and send e-mails to predefined 
recipients. Different opening times can be set for the cash register and the shop areas 
of the gas station.

In the event of a dangerous situation, continuous recording at a higher frame rate and 
other actions (e.g. a telephone call) can be triggered by clicking Manual Alarm.

Required Components

•	 1 x MOBOTIX Q24M-Sec (cash register area)

•	 2 x MOBOTIX D24M-Sec (pumps)

•	 1 x MOBOTIX M24M-R16 (shop)

•	 1 x PoE switch for supplying power to four cameras

•	 Uninterruptible power supply (UPS) units for supplying the cameras, the switch and, 
if desired, the computer

•	 Professionally laid Ethernet cables guided to the mounting positions of the cameras 
(no separate power cables required)

•	 Computer installed with a Windows, Mac OS X or Linux operating system

•	 Configured DSL router registered with a VoIP provider (required for telephone and 
e-mail notification and external access via DynDNS)

1.2.3	 Hotel With Nine Cameras

In this scenario, an entire hotel is guarded using a MOBOTIX system. The video sequences 
are recorded in the cameras.
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The cameras at the main entrance and the delivery entrance are event-controlled. Each 
of these cameras is connected to a MOBOTIX ExtIO. Additionally, these cameras can be 
used as a door intercom and to remotely open the doors. In the underground garage, 
there are two event-controlled cameras that record cars entering the garage or persons 
present in the area. Cameras in both hallways on the second floor and the third floor, in 
the gym and in the swimming pool area record all events when persons are present in 
these areas. A camera located in the lobby makes continuous recordings with a variable 
frame rate of all events in the entire reception area (lower frame rate for normal operation, 
max. frame rate in case of an alarm).

Hotel staff can trigger an alarm at the reception desk using the Manual Alarm feature. 
This alarm can be configured to trigger notification via VoIP telephone call (and/or e-mail) 
to be sent to predefined recipients.

Hotel staff can use the following additional features with the connected ExtIO modules 
for the cameras at both entrances:

•	 Door Opener: Opens the door connected to the corresponding camera.

•	 Light: Switches on the light located near the camera.

•	 Speaker: Switches on the camera microphone and the ExtIO on the speakers of the 
computer. When the cameras are displayed one after another using the Camera 
Sequencer, the software plays the sound from the active camera.

•	 Microphone: Activates the sound on your computer microphone and feeds it to the 
camera speaker (or the connected ExtIO), allowing your voice to be heard.

•	 Acoustic Alarm: Plays a preselected audio file over the camera speaker (or the 
connected ExtIO).

Required Components

•	 6 x MOBOTIX Q24M-Sec, 5 with In-Ceiling Set

•	 1 x MOBOTIX D12D-Sec with 1 L22 lens, 1 L43 (parking lot)

•	 2 x MOBOTIX M24M with L22 lens

•	 1 x PoE switch with at least nine PoE ports

•	 Uninterruptible power supply (UPS) units for supplying the cameras and the switch

•	 Professionally laid Ethernet cables guided to the mounting positions of the cameras 
(no separate power cables required)

•	 Computer installed with a Windows, Mac OS X or Linux operating system

•	 Configured DSL router registered with a VoIP provider (required for telephone and 
e-mail notification and external access via DynDNS)
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1.3	 Setting Up A Video Surveillance System – Overview

We will describe the most important steps for basic installation in this section. These steps 
are the same for all scenarios.

For thorough instructions regarding camera installation, see the section Installation in the 
corresponding Camera Manual. For information on the power supply and connecting 
cameras to the network, see the section Connecting The Camera To The Network And To 
The Power Supply in the corresponding Camera Manual.

Mounting And Connecting The Cameras

•	 Installing the Ethernet cable and mounting the cameras: Determine where you want 
to mount the cameras. Run the Ethernet cable to the mounting position of the camera. 
Mount the cameras and connect the Ethernet cable to the corresponding camera:

–	 In the House example, one camera (Q24M) is mounted over the front door and 
the other camera is mounted behind the house under the roof overhang.

–	 In the Gas Station example, two D24M-Sec cameras monitor the pumps in order 
to record persons and vehicles in the area. The shop camera is mounted in one 
corner of the room and the register camera is mounted on the ceiling above the 
cash register area so as to monitor both customers and the register.

–	 In the Hotel example, one Q24M-Sec is mounted at the main entrance of the 
hotel and the corresponding ExtIO is mounted next to the door of the main 
entrance where it serves as a door intercom. Two M24M-R16 cameras monitor 
the entrance and the rear side of the underground garage. The remaining five 
Q24M-Sec cameras are installed in the planned positions using In-Ceiling Sets 
(in the hallways of the second and third floors, in the swimming pool area, in 
the gym, and above the reception desk). The camera above the reception desk 
is mounted in the ceiling so as to monitor the entire reception area.

•	 Setting up the power supply: Set up the power supply of the camera. Use either a 
commercial PoE switch, MOBOTIX Network Power Racks/Boxes or MOBOTIX power 
supply units in conjunction with Network Power Adapters.

•	 Connecting the cameras: Connect the Ethernet cable from the cameras to the PoE 
switch (or the Network Power Rack/Network Power Adapter). The PoE switch is con-
nected to the local area network (LAN) via another Ethernet cable.

•	 Checking the cameras: Inspect the LEDs of the operating cameras to make sure 
that they indicate that the camera is operating normally.

The MOBOTIX cameras are now ready to use and available in the local area network. 
They can now be integrated into MxEasy.
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Integrating The Cameras Into MxEasy

•	 Installing MxEasy: Insert the MxEasy CD (if available) or download the MxEasy software 
for your operating system. Install the application (see Section 2.3, “Installing MxEasy”).

•	 Automatic search for cameras: Launch MxEasy. The application automatically finds 
all MOBOTIX cameras in the local network and shows a preview image for each 
camera that is directly accessible. You can manually add cameras later on, which 
are outside of the local network (e.g. in your summer cottage). At this point, you 
can assign specific names to the individual cameras and set new access data 
(see Section 3.1.1, “Searching MOBOTIX Cameras”, as well as Section 3.1.3, “Adding 
Remote Cameras Using DynDNS”).

•	 Network configuration for the cameras: MxEasy will prompt you to enter the IP 
addresses to be used for the cameras in the network (or you may select the option 
DHCP). If there is a DSL router in the network, MxEasy automatically selects DHCP 
(see Section 3.1.2, “Selecting And Adding New Cameras”).

•	 Resetting to MxEasy defaults: When prompted, you may choose whether or not you 
wish to reset the cameras back to MxEasy defaults. You may also choose to retain the 
current settings if you have already configured the cameras using MxEasy or if MxEasy 
is to be installed on several computers. MxEasy automatically recognizes whether 
or not these settings have been applied and recommends the appropriate option.

After you have completed these steps, the cameras are displayed in MxEasy.

Further Steps

•	 Displaying live images: Click Next Camera to display each camera one after another 
in the main window of MxEasy and select the desired image section (see Section 3.3, 

“Displaying Live Images And Monitoring Alarms”).

•	 Using image sections and zoom functions: If necessary, define different image 
sections and change the zoom settings (see Section 3.5, “Image Sections And Digital 
Zoom Functions (PTZ)”).

•	 Setting up alarms and recordings in the alarm planner: Define the time period 
during which alarms are to be detected and select the events for which the camera 
alarms are to be triggered (see Section 3.6, “Setting Up Alarms And Recordings”).

•	 Selecting the operation mode: Select how MxEasy should record video and audio 
data ‑ Alert Mode records continuously and Alarm Planer Mode records according 
to the times defined in the weekly time table. Switched Off Mode stops recording 
(see Section 3.6.1, “Operation Modes Of MxEasy”).

•	 Creating manual alarms: Click this button to trigger a manual alarm (this feature 
can also be used to test the recording functions).

•	 Evaluating recordings: Evaluate the recorded video sequences (see Section 3.8, 
“Playing Back And Evaluating The Recordings”).

•	 Creating users and passwords: If the computer is accessible to several users, make 
sure to set up passwords for the Administrator, Owner, User and Guest access 
levels (see Section 3.9, “Creating Users And Passwords”) once you have finished the 
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configuration of the system. Appendix B, “Access Rights For User Access Levels”, 
contains a list of the rights assigned to each user level.

When you have completed these steps, see Chapter 4, “Advanced Operation”, for further 
configuration options:

•	 Printing and saving images and exporting recordings: You can print and save 
images from the camera at any time (live images or recordings) and even export 
recorded video sequences separately (see Section 4.1, “Saving, Printing And Exporting”) 
using the print feature and the convenient preview option.

•	 Saving the settings: Save your settings so that you can easily restore the selected 
settings later (for example, after experimenting with the image settings) (see Section 4.2, 

“Saving And Restoring Settings”).

•	 Activating the “Privacy Mode”: Activate this mode to stop all recording features 
and to prevent anyone from accessing the cameras controlled by MxEasy. While 
this lock can be deactivated directly from the current computer, you will need the 
user name and password set in this dialog to deactivate the lock from a different 
computer (see Section 3.7, “System Shutoff ‑ Privacy Mode”).

Note

All MOBOTIX cameras controlled by MxEasy can use different recording targets. 
Depending on the model and type of camera used, they can store the audio/video 
data on internal storage media (SD cards) or on file servers.

Newer cameras (Q22M, Q24M, D24M, M24M, all except Basic and Web models) and 
R models have factory-installed SD cards and are preconfigured for recording “out-
of-the-box”. At present, MxEasy cannot change the recording target of the cameras. 
To change this basic configuration setting, you need to change the configuration on 
the camera itself (see Section 4.7, “Recording Targets ‑ SD Cards And File Servers”). 
This section also contains more information on the different recording targets.
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2	 System Installation

2.1	 System Requirements

Computer System

The computer system on which MxEasy is installed must meet the following criteria in 
order to ensure optimum operation of your MOBOTIX system:

•	 Computer with a current operating system (Windows XP or higher, Mac OS X 10.4 or 
higher with Intel processor, Linux with latest kernel available). Macintosh computers 
with PowerPC architecture are no longer supported.

•	 Monitor with a minimum resolution of 1024 x 768 pixels. The resolution should be 
higher (at least 1280 x 1024 pixels) in order to be able to use the full-screen display 
of one or more cameras.

•	 2-button mouse with scroll wheel. MxEasy also supports joysticks and devices with 
a touch panel.

•	 To create the network connections, you need a switch or router with switch functionality.

2.2	 Power Supply And Network Connection Of Cameras

The MOBOTIX cameras can be supplied with power using a Network Power Adapter 
(MX-NPA-PoE) or a switch that supports the PoE standard IEEE 802.3af. Both of these 
methods will be briefly described here. For information about additional power supply 
options and for more details, see the section Network And Power Connection in the cor-
responding camera manual.

For the Q24M, you 
should use the new 
blue MX-NPA-PoE-Set. 
Previous MOBOTIX 
network power acces-
sories such as the NPA 
Set, Power Box and 
Power Rack (MX-NPA-
Set, MX-NPR-4 and 
MX-NPR8/20) are 
not suitable for use 
with the Q24M
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2.2.1	 Power Supply When Connected Directly To A Computer

1.	 Connect the factory pre-installed cable of the camera to the Camera connector of 
the Network Power Adapter.

2.	 Connect the PC/Power connector of the Network Power Adapter to the Ethernet 
port of the computer.

3.	 Plug the RJ45 connector of the external power unit into the LAN/Power connector 
of the Network Power Adapter.

2.2.2	 Power Supply And Network Connection With A PoE Switch

Connect the factory pre-installed cable of the camera to the Ethernet connector of the PoE 
switch/router. The switch/router must support the PoE standard IEEE 802.3af.

MX-NPA-PoE-Set 
(power supply and blue power adapter)

Patch cable

10.8.0.99

192.168.1.12 (255.255.255.0)

Patch cable

The IP addresses in 
the diagram are shown 
only as an example

The IP addresses in 
the diagram are shown 
only as an example

Patch cable

10.8.0.99

192.168.1.12 (255.255.255.0)
Patch cable
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2.3	 Installing MxEasy

The current version of MxEasy is available for download on the MOBOTIX website (www.
mobotix.com under Support > Software Downloads > MxEasy).

Note

Only registered users are permitted to download MOBOTIX software from the website. 
If you are not yet a registered user with MOBOTIX, why not register now? Registered 
users have the following benefits:

•	 Access to the entire range of the freely accessible MOBOTIX software.

•	 Automatic subscription to the newsletter (if desired) to inform you about the 
latest MOBOTIX products.

2.3.1	 Installation On Windows Computers

•	 Open the file for automatic installation (MxEasy_*_Setup.exe). You receive this file:

–	 Download the file (MxEasy_*_Setup.exe) from the MOBOTIX website (release: 
MxEasy Windows), and save the file to your computer (for example, on the 
Desktop).

–	 If you have received installation media (CD, DVD, USB stick), you can launch the 
installation file directly from the storage device (the installation file may be opened 
automatically after you have inserted the storage device).

•	 Follow the instructions of the installation assistant.

2.3.2	 Installation On Mac OS X Computers

•	 Open the file for automatic installation (MxEasy *.mpkg). You receive this file:

–	 Download the file (MxEasy *.mpkg.zip) from the MOBOTIX website (release: 
MxEasy Macintosh), and save the file to your computer (for example, on 
the Desktop). Unpack the file by double-clicking it.

–	 If you have received installation media (CD, DVD, USB stick), you can launch the 
installation file directly from the storage device.

•	 Follow the instructions of the installation assistant.

2.3.3	 Installation On Linux Computers

Because there are a number of different distributions available for Linux computers, MOBOTIX 
offers several different installation files. The supported distributions are listed for each 
release on www.mobotix.com.

http://www.mobotix.com
http://www.mobotix.com
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Automatic Installation With Package Manager

•	 Install the file for automatic installation that corresponds to your distribution (MxEasy*.
deb/rpm). You receive this file:

–	 Download the file (MxEasy*.deb/rpm) for your distribution from the MOBOTIX 
website (release: MxEasy Linux) and save the file to your computer (for 
example, in the /tmp directory).

–	 If you have received installation media (CD, DVD, USB stick), you can open instal-
lation file directly from the storage device.

•	 Please note the documentation of the applicable Package Manager.

Manual Installation

•	 Unpack the file for manual installation (MxEasy*.tar.bz2). You may obtain this 
file using one of the following options:

–	 Download the file (MxEasy*.tar.bz2) for your distribution from the MOBOTIX 
website (release: MxEasy Linux), and save the file to your computer (for 
example, in the /tmp directory).

–	 If you have received installation media (CD, DVD, USB stick), copy the installation 
file for your distribution onto your computer, for example to the /tmp directory).

•	 Open the file PLATFORM NOTES in the unpacked directory and follow the installa-
tion instructions described.

Note

By factory default, MxEasy checks at startup whether a new program version has 
been released on the MOBOTIX website and offers to update the software. For more 
information, see Section 5.6, “Software Update”.
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3	 Getting Started
The previous chapter described the installation of MxEasy. In this chapter, you will learn 
everything you need to know to get started with MxEasy.

When you launch the program for the first time, MxEasy Wizard automatically finds all 
MOBOTIX cameras that are available in the network and guides you through the initial 
configuration for the selected cameras. You can then set up the cameras quickly and 
easily using MxEasy.

•	 Section 3.1, “Using MxEasy For The First Time”

•	 Section 3.2, “Elements In The Program Window And Program View Modes”

•	 Section 3.3, “Displaying Live Images And Monitoring Alarms”

•	 Section 3.4, “The Most Important Camera Views And Image Settings”

•	 Section 3.5, “Image Sections And Digital Zoom Functions (PTZ)”

•	 Section 3.6, “Setting Up Alarms And Recordings”

•	 Section 3.7, “System Shutoff ‑ Privacy Mode”

•	 Section 3.8, “Playing Back And Evaluating The Recordings”

•	 Section 3.9, “Creating Users And Passwords”

See Appendix B, “Access Rights For User Access Levels”, for a list of the rights assigned to 
each user level (Administrator, Owner, User, Guest). For additional information on saving, 
printing and exporting recorded audio and video data as well as saving and restoring 
settings, see Chapter 4, “Advanced Operation”.

3.1	 Using MxEasy For The First Time

3.1.1	 Searching MOBOTIX Cameras

When you launch MxEasy for the first time, MxEasy Wizard automatically starts searching 
for MOBOTIX cameras and displays all detected cameras in a list. The camera list will be 
updated automatically as soon as new MOBOTIX cameras are connected to or removed 
from the network.

Note

If MxEasy does not find any cameras (the camera selection list contains no entries 
in this case), check the firewall settings of your computer. If necessary, customize 
the settings for MxEasy to allow connections to and from MxEasy. If you do not 
have permission to modify these settings on your computer, contact your system 
administrator for assistance.
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MxEasy Wizard: Selecting Cameras

In this dialog, MxEasy lists all detected cameras and displays the current operating status 
of each camera. In order to select the correct cameras, this dialog shows a preview image 
of the last selected camera and the camera information listed in the columns:

•	 Camera list/name: Click one of the columns to sort the camera list accordingly. You 
can change the order in which the cameras are sorted by clicking again. Double-click 
the camera name to change it or click Edit in the pop-up menu.

•	 Filter: You can enter any filter criterion in this field to narrow the list of cameras dis-
played (for example, if you enter 3.4.4.7, the list will be narrowed down to the 
cameras that use this particular software version).

•	 Legend: MxEasy also automatically monitors and displays the operating status of 
all cameras. There are five statuses that MxEasy cameras can display. These statuses 
are displayed as colored circles listed before the names of the cameras:

–	 Green: The camera is ready, responding and can thus be integrated immediately.

–	 Green with blue lock: The camera can be integrated, but it is password-protected 
and the password has not yet been entered into MxEasy. Right-click the camera, 
select Authenticate and enter the correct user name and password. Once a valid 
user name and password have been entered, the symbol changes to a green 
circle and the lock disappears.

–	 Green with red lock: This camera is in Privacy Mode. A camera in this mode 
cannot be accessed in any way until the camera is unlocked again. Note that 
this mode deactivates the audio channel as well as all event and recording 
features of the camera.

–	 Blue: Besides the cameras in the same subnet as your computer that have already 
been added, MxEasy also finds new MOBOTIX cameras with factory IP addresses 

Legend

Camera list

Preview 
image

Filter



20/132 MxEasy User Manual: Getting Started

© MOBOTIX AG  •  Security-Vision-Systems  •  Made in Germany

www.mobotix.com  •  sales@mobotix.com

using the Bonjour service. Since new cameras are usually in a different subnet, 
it is not possible to establish a video connection.

This usually happens if the IP addresses in the network are automatically assigned 
by a DHCP server (e.g. in the DSL router). The computer (and the cameras already 
added) are in a different subnet (e.g. 192.168.178.x) than the MOBOTIX 
cameras with factory IP addresses (always 10.x.x.x). If such a camera is 
added to the system, MxEasy can automatically integrate them into the subnet 
of the computer.

–	 Yellow: The camera has been found, but it cannot be integrated at this time. This 
is the case if MxEasy is busy determining the status of the selected camera, for 
example. The yellow circle will be replaced by a green or red circle after a short time.

–	 Red: The camera has been found but is not responding. This status occurs when 
a camera has been restarted but can also be caused during normal operation 
by a disruption in the HTTP connection (network error, firewall).

•	 Preview image: MxEasy displays the live images from the selected camera in this 
field as long as this camera is reachable (if more than one camera is selected, the 
preview window displays the images from the last camera to be selected).

Adding MOBOTIX Cameras Manually

Click the Add Cameras button in the MxEasy Wizard or on the Add command in the 
context menu of the camera list to add cameras located outside the network (e.g. on the 
Internet) as MxEasy cannot find these cameras automatically.

For more information on DynDNS and how to add “remote cameras”, see Section 3.1.3, 
“Adding Remote Cameras Using DynDNS”.

Descriptive name of the 
camera

Camera port on the 
router

User name and pass-
word for accessing the 
camera

DynDNS name of the 
router
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3.1.2	 Selecting And Adding New Cameras

Selecting Cameras

You can now select the cameras that you would like to add to MxEasy. To select more 
than one camera, simply use Shift-click for a block selection or the Command key and 
left-click for individual selection. Command key + A selects all cameras. The preview always 
displays live images from the selected camera (if more than one camera is selected, this 
window always displays the live images from the last camera to be selected).

Adding Cameras

Once have you selected the desired cameras, 
click Continue and confirm the security prompt 
by clicking OK.

If some of the selected cameras are password-
protected (status: Authentication required), MxEasy 
will prompt you to enter the corresponding user 
name and password.

In this step, MxEasy Wizard also saves the entire 
configuration of all selected cameras. As a result, 
this configuration can be easily restored at a 
later time.

Select multiple 
cameras using the 
Shift or Command 
key
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Network Configuration

Network configuration for MxEasy Wizard will only be carried out if one of the selected 
cameras displays the status  (Invalid network).

If your computer automatically obtains its IP address 
from a DHCP server (e.g. from a DSL router), then 
this is certainly the best choice for that specific 
camera and most likely for all other cameras 
that have been found in a different subnet (Get 
IP address automatically option). If you have 
assigned a fixed IP address to your computer, you 
will probably want to assign fixed IP addresses 
(issued by your system administrator) to every camera (the Use this IP address option). 
Normally, you enter the same configuration used for the network settings of your computer.

Once you click OK, the selected cameras will be reconfigured automatically. The cameras are 
now in the same subnet as your computer and are marked as Reachable in the camera list.

Resetting The Camera Configuration

You can choose whether to reset the cameras to MxEasy defaults in the next step.

Note

We highly recommend that you always reset the configuration of the cameras 
to MxEasy defaults.

Click Continue to proceed.
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Setting A User Name And Password

If you opted to reset all cameras to MxEasy defaults in the previous dialog, you can now 
set one user name and a password for all cameras. Note that doing so will also disable 
public access to the cameras. Leave the fields empty if you would like to skip this step.

Caution

For security reasons, it is highly recommended to assign a user name and pass-
word to protect the cameras from unauthorized access. If you would like to set 
a user name and password later on, please see Section 5.3, “Setting Up A Global 
User For All MOBOTIX Cameras”.

Caution

Make sure that you store information on user names and passwords in a secure 
location. If the administrator password is lost, the passwords for the cameras must 
be reset at the factory. This service is subject to a service charge!

If no user name and password have been entered, MxEasy uses the factory defaults 
(user admin, password meinsm). This automatically enables public access to the 
Guest screen via a browser window.

Click Continue to proceed.
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Determining The Mounting Position And The Image View (Hemispheric Cameras 
Only)

If MOBOTIX Hemispheric cameras (e.g. a Q24M) are selected in the selection list, MxEasy 
Wizard displays the following dialog for each of the cameras, one after another. Here, 
you can determine the mounting position and the desired view of each camera (wall or 
ceiling). Depending on its mounting position, the camera provides different views.

Closing MxEasy Wizard

The cameras are displayed in the following dialog after the integrated cameras have been 
reconfigured:
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Click Continue and Finish in the the next dialog to close the Wizard and display the 
selected cameras in MxEasy.

MxEasy saves the configuration of the cameras before they have been integrated into the 
system for the first time (and each time the program is launched). This way, you can safely 
change the camera settings when integrating the cameras into MxEasy. The Backup 
Configuration button offers you the option to undo changes you have made. For more 
information on saving and restoring configurations, see Section 4.2, “Saving And Restoring 
Settings”.

Notes On Closing MxEasy Wizard

•	 Cameras that are no longer needed should be deleted from MxEasy. This way, you 
can reset the connection to the MxEasy computers. Before these cameras are deleted, 
they should be restored to the settings they had prior to initial integration in MxEasy 
(the Camera > Remove Camera menu command). MxEasy will prompt you to do 
this when removing the cameras. This process can take place fully automatically.

•	 In addition to integrating cameras that are available in the local network, you can also 
use remote cameras in MxEasy (for example, a camera available online via DynDNS; 
see Section 3.1.3, “Adding Remote Cameras Using DynDNS”, on how to do this).

•	 When there are a large number of cameras in the network, it may take a moment for 
MxEasy to create the camera list and retrieve the camera information. However, you 
can select a particular camera entry before the entire list has been populated. The 
information and the preview image for this camera will be found and displayed first.

•	 The first time you launch MxEasy or the first time you use MxEasy to access MOBOTIX 
cameras, the Microsoft Windows firewall may display a warning dialog. Allow access 
for MxEasy.

3.1.3	 Adding Remote Cameras Using DynDNS

MxEasy cannot find cameras that are outside of the local network. These cameras need to 
be added manually to the camera list. The simplest case is a camera that can be reached 
using a fixed IP address. To do so, select Camera > Add Cameras from the menu and add 
the fixed IP address of the camera in the Camera Selection dialog of the MxEasy Wizard.

In the majority of cases, however, the cameras are connected to the Internet using a 
broadband connection with dynamic IP addresses that change every day. This kind of 
Internet connection requires using DynDNS (dynamic domain name resolution). The dynamic 
DNS process allows using a given name registered with a free DynDNS service provider 
(e.g. www.dyndns.org) instead of a fixed IP address (e.g. 213.117.53.215). The 
integrated DynDNS client of your broadband router automatically updates the IP address 
of the DynDNS service if the IP address changes. This service thus allows adding the cam-
era using its DynDNS name (e.g. mycamera.dyndns.org:19801) in the Camera 
Selection dialog of the MxEasy Wizard.
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Note

The IP addresses of cameras, routers, the ports and the DynDNS name mycamera.
dyndns.org are only examples. Make sure that you are not using the same 
names and ports, but rather assign your own names and ports for accessing your 
cameras via DynDNS.

Caution

•	 It is highly recommended to only use flat rate tariffs for the Internet connec-
tion of the cameras or the router. Using a different tariff may produce costs 
that are too high.

•	 Make sure that the factory access data of the cameras (user name “admin” 
and password “meinsm”) have been changed! If you would like to set a 
user name and password later on, please see Section 5.3, “Setting Up A Global 
User For All MOBOTIX Cameras”.

Scenario: Internet Connection Of The Cameras Using A Broadband Router

In this scenario, all cameras are connected to the Internet via a broadband router with a 
flat rate tariff. Note that you only need a DynDNS name for the router itself. This name and 
the corresponding access data are then entered in the router’s DynDNS client. The router 
uses port forwarding to provide access to the individual cameras, e.g. mycamera.
dyndns.org:19801 for the first camera, mycamera.dyndns.org:19802 for the 
second, etc. (the numbers following the colon “:” are examples for the individual ports).

A port allows offering different services on one computer using the same IP address. 
This way, one computer can be used as web server (port 80) and as e-mail server (port 
25 for sending, port 110 for receiving e-mails) at the same time.

The router can assign certain ports of its external interface to specific internal addresses 
(this is called port forwarding). For more information on ports, please see the infor-
mation on en.wikipedia.org using  “TCP port numbers” as search term.

The port forwarding itself is also configured on the router. Ports of the router’s external IP 
address (19801 and 19802 in the example) are assigned to local (internal) IP addresses 
of the cameras (192.168.178.201 and 192.168.178.202). In our example, the 
two ports are assigned to the following cameras (or more precisely - their IP addresses):

•	 19801 → 192.168.178.201

•	 19802 → 192.168.178.202
Once this has been configured, the router will forward a query from the Internet to port 19801 
of its external IP address 213.63.87.154 to the local IP address 192.168.178.201 

http://en.wikipedia.org
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and thus to camera 1. In the same manner, the router will be forwarding queries on the 
external port 19802 to the local IP address 192.168.178.202, i.e. to camera 2.

•	 1: The router updates its IP address at the DynDNS server.

•	 2: The computer asks for the IP address of mycamera.dyndns.org.

•	 3: The DNS service sends the IP address 213.63.87.154 back to the computer.

•	 4: The computer uses different ports (19801 und 19802) when accessing the 
router’s external IP address 213.63.87.154.

•	 5: The router forwards queries on the ports 19801 and 19802 of its external IP 
address 213.63.87.154 to the internal IP addresses (192.168.178.201 
and 192.168.178.202, respectively).

Registering A DynDNS Name

In this first step, you need to create an account at a suitable DynDNS service, if you have 
not already done so (e.g. www.dyndns.org). Make sure that you keep the access data 
(user name and password) stored in a safe place. You will need this information later on, 
when configuring the DynDNS client of the camera or the router.
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In this step, you should also register the DynDNS name for the router that you would like 
to use for accessing the remote cameras. The name in our example would be “mycam-
era”. The DynDNS service providers usually offer a selection of domains to add after the 
DynDNS name (separated by a dot). For this example, we selected “dyndns.org”. The 
name for accessing the cameras thus always starts with “mycamera.dyndns.org”.

Configuring The Router

•	 Setting up the DynDNS client on the router: Open the user interface of the router 
in your web browser by entering its IP address or its mDNS name (e.g. 
“http://192.168.178.1” or “http://fritz.box”, respectively). If this 
does not work, please read the documentation of your router to find the correct IP 
address for accessing the router.

Open the broadband router’s configuration page of the DynDNS client in the web 
browser. Read the documentation of the router or search the router’s online help to 
find more information on the “DynDNS” topic.

Enter the DynDNS name and the access data you have registered with your DynDNS 
provider as described in the documentation. Furthermore, you should active the 
remote configuration of your router (at least temporarily).

•	 Setting up port forwarding: Open the broadband router’s configuration page for 
port forwarding in the web browser. Read the documentation of the router or search 
the router’s online help to find more information on the “port forwarding” topic.

Assign one port to every local IP address (192.168.178.201, 192.168.178.202) 
you would like to access from outside of the local network (e.g. 19801 → 
192.168.178.201, 19802 → 192.168.178.202, etc).

Testing the DynDNS Configuration

Once you have completed the previous steps, you should run the following tests:

•	 Test DynDNS: Open your web browser and enter the DynDNS name you registered 
(example: http://mycamera.dyndns.org). If everything has been configured 
properly and the remote configuration has been activated (see Section “Configuring 
The Router”), you should see the user interface of the router.

•	 Test the cameras: Open your web browser and enter the DynDNS name and the port 
of the first camera (example: http://mycamera.dyndns.org:19801). You 
should now see the user interface of the camera and the browser should prompt 
you for access data (user name and password). Test all other cameras that are to 
accessed remotely using the appropriate ports (see above).

Caution

Deactivate the remote configuration of your browser if you had activated it in the 
Section “Configuring The Router”.
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Adding A Remote Camera In MxEasy

To add a remote camera using DynDNS, proceed as described in Section “Adding MOBOTIX 
Cameras Manually”. Instead of an IP address, enter the DynDNS name of the router and 
the corresponding port of the camera:

•	 Name: Descriptive name for easy identification of the camera (“Back door” in 
this example)

•	 Address: mycamera.dyndns.org

•	 Port: 19801

•	 User name: User name for accessing the camera (“remoteuser” in this example)

•	 Password: Password for the user name

If everything has been configured properly, the status will change to green  and 
MxEasy shows a preview image for this camera.

Activating SSL Encryption

Once this has been activated, all communication to and from the camera is encrypted 
using SSL. Using this encryption method makes “eavesdropping” on the data and access 
information (virtually) impossible. Proceed as outlined below to activate SSL encryption 
on the camera.

•	 Click on the Next Camera button until you see the first remote camera in the MxEasy 
main window (this would be the “Back door camera in our example).

•	 Click on the Camera Options button and select the Connection tab in the dialog.

•	 Activate the Use Secure Connections (SSL) 
checkbox.

•	 Click on Apply or on OK to apply the changes 
to the camera.

•	 Reboot the camera if prompted you to do so.

Descriptive name of the 
camera

Camera port on the 
router

User name and pass-
word for accessing the 
camera

DynDNS name of the 
router
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All communication to and from the camera is now using an SSL-encrypted connection. 
Note that you can also use the encrypted connection in a web browser by entering the 
camera’s address as in the example below:

https://mycamera.dyndns.org:19801

3.2	 Elements In The Program Window And Program View Modes

After the Wizard is finished and all preparations have been completed, MxEasy displays 
the live images. Up to four integrated cameras are displayed simultaneously. The images 
are displayed in the Standard or Panorama view modes of the MxEasy program window, 
which is divided into the areas shown below.

Standard View Mode Of The MxEasy Program Window

Note

Once the Wizard has finished, MxEasy will start in Panorama view mode, if at least 
half of the cameras are Hemispheric models and these cameras are running in 
Panorama mode. For further information on the Panorama view mode, please see 
Section 3.2.2, “Program View Modes”.

Main window

Menu bar

Image bar with 
camera/event 
windows

Tool Tips for MxEasy 
elements

Info bar 1

Info bar 2

Toolbars

Dynamic toolbar

Status bar
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3.2.1	 Areas Of The MxEasy Program Window

Main Window

Depending on the view you have selected, this area of the program window displays the 
live image of a camera, the recorded images of a camera, the camera overview or a cal-
endar for alarm planning. When MxEasy is launched for the first time, the program window 
appears in Standard mode and displays the live image of the first camera. There are two 
information bars located above and below the main window. In the Standard and Player 
views, these bars display specific information on the camera currently displayed in the main 
window. For more information, see Section 3.2.1, “Areas Of The MxEasy Program Window”.

Image Bar

Depending on the current view, the image bar contains the live images or recorded event 
images of up to three cameras. Live images are displayed with a camera symbol and 
event images are displayed with a cassette symbol in the upper right-hand corner of the 
image. For more information on the image bar, see Section 3.2.2, “Program View Modes”.

Note

When MxEasy is launched for the first time, there are usually no event images. This 
is always the case if the integrated cameras are new and have not recorded any 
event images yet. MxEasy then displays a placeholder image in the bottom right-
hand corner of the event image area. Because the image bar is filled dynamically 
according to the number of integrated cameras, MxEasy may display this image 
multiple times.

Toolbars

Using the buttons located around the main window, you can quickly and easily perform 
the most important functions for setting up and operating your MOBOTIX video surveillance 
system. These include functions for live surveillance, controlling the cameras, playing back 
recorded video and audio data and configuring integrated cameras.

The following buttons are among the software’s special features and are used to activate 
the different function areas of MxEasy. These buttons can be used to adjust the settings in 
many different function areas of the program. Clicking these buttons causes a number of 
different buttons to appear at the bottom of the program window in the dynamic toolbar. 
You can use these buttons to make detailed settings:

•	 Player mode: MxEasy switches to Pleaser mode and displays the events of the 
camera in the main window. The other cameras (if available) are displayed in the 
image bar. Empty areas in the image bar are filled with the camera’s latest event 
images.
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•	 Alarm Planner: Displays the alarm settings for the current camera in the calendar 
view. You can use this view to set the times and sensors. The cameras then use these 
settings to trigger alarms, actions and messages.

•	 Image Settings: Here, you can adjust the saturation, image brightness, contrast and 
sharpness of the camera images to suit your needs. Using the Exposure Window 
feature, the camera can adapt the exposure to the contents of specific image areas.

•	 Image and Recording Formats: Here, you can set the image format for live images 
and recording and adjust the image quality and the frame rate. You can also deter-
mine whether the camera’s audio channel is to be recorded and whether the displayed 
image or the full image (or sometimes a section thereof) is to be recorded.

•	 PTZ Views: These buttons allow for simple setting (and subsequently selecting) 
predefined image areas that have been created using the camera’s digital zoom 
features.

Clicking Player Mode or Alarm Planner changes the content of the main window (see 
Section 3.2.2, “Program View Modes”).

Buttons With Selection Menus

Many buttons are not only used to activate or deactivate a particular 
feature. These buttons also allow you to set certain values by selecting 
them from a menu. Selection menus are displayed by right-clicking 
the button or clicking the small triangle at the bottom right-hand 
corner of the button.

Tool Tips For Buttons And Other Elements Of The User Interface

Hover the mouse pointer over a button or element to display the corresponding Tool Tip. 
Tool Tips are available for all buttons and other elements on the user interface. If you do 
not wish to display the Tool Tips, you can choose to display the headers only (Tools > 
Detailed Tool Tips menu command).
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Menu Bar

Using the menu bar, you can access most of the features and settings that can be activated 
using the buttons in the toolbars. There are certain features that can only be activated 
using the menu bar, for example switching the current environment.

Status Bar

MxEasy displays certain information about the runtime at the bottom of the application. 
When the mouse is moved over camera windows or buttons, for example, the status bar 
displays the name of the camera or a short description of the element.

Information Bars

MxEasy shows the relevant information for the current view mode in the two blue bars 
above and below the main window.
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3.2.2	 Program View Modes

Standard

This view of the main window is filled with the live image of the first camera that has been 
integrated into the system. The image for the latest event of this camera is displayed in 
the image bar at the bottom. The three other windows in the image bar are filled with 
live images from other cameras.

If there are fewer than four cameras in the system or fewer than four cameras have been 
activated for Standard mode (see the Camera Overview section), the empty windows in 
the image bar are filled with additional event images from the main camera.

Elements of the Standard mode:

Normal Mode Vs. Panorama View

When displaying images from wall-mounted MOBOTIX Hemispheric cameras (e.g. Q24M), 
MxEasy can be switched to the “Panorama” view, which displays the images with an 
aspect ration of 8:3 (instead of the standard 4:3). In this mode, the image bar is located 
below the window of the main camera. The images of the image bar are ordered from 

Date/time of the main 
camera

Live image in main 
window

Latest event image of 
the main camera (if 
available)

Live images of up to 
three more cameras

Symbol for live image
Camera Name

Symbol for recording 
target

Date/time of the latest event of 
the main camera

Live frame rate of the 
main camera
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left to right instead of top to bottom. The window at the bottom right-hand side is used 
to display the latest event image.

To activate the Panorama view mode, open the context menu using the Camera Overview 
and Layouts button or the View > Layout menu.

Notes

•	 This view is particularly suited for the Hemispheric cameras (e.g. Q24M), which 
records images in Panorama mode with an aspect ratio of 8:3.

•	 This aspect ratio of the main window is retained, even when a camera image 
with an aspect ratio of 4:3 (e.g. VGA) is displayed in the main window.
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Player View

This mode is used to search for and play back recorded data. It is activated by clicking 
the Player Mode button from Standard or Panorama view mode The main window now 
displays the image for the latest event recorded by the main camera. The image bar 
displays the live images of the first four integrated cameras.

Additional buttons are displayed below the main window. These buttons can be used to 
play back and navigate through recorded video and audio data.

Elements of the Player mode:

Click the Player Mode button again to return to Standard mode. When you restart MxEasy, 
the program automatically activates the mode that had been activated before the program 
was closed (Standard mode or Player mode).

MxEasy displays an icon for the current Recording Target in 
the lower information bar of the main window. Hold the mouse 
pointer over the icon in the information bar to see this tool tip.

Date/time of the 
MxEasy computer

Event image in main 
window

Last image

Slider bar for event 
search

3 live cameras in 
image bar

Live image of the cur-
rent camera

Symbol for recording
Camera Name

Symbol for recording 
target

Current imageFirst image Player controls
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Note

Double-clicking the event image in the image bar also switches from Standard to 
Player mode. Another double-click into the live image of the image bar switches 
back again to Standard mode.

Camera Overview

To use this view, click on the Camera Overview and Layouts button or on the View > 
Camera Overview menu command. This view shows the live images of all cameras that 
have been integrated into the system in a grid with camera windows of the same size. 
MxEasy uses the space of the program window that is usually occupied by the main 
window, the image bar and the information bars.

Click the Camera Overview and Layouts button again to return to Standard mode.
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Camera Management

To use this view, click on the View > Camera Management menu command. Note that 
this also activates the Camera Overview and Layouts button. If you would like to leave this 
view again, it is sufficient to deactivate the button or the View > Camera Management 
menu command.

This view displays all of the integrated cameras (i.e. up to 16 cameras). Standard mode 
and Player mode display up to four of all cameras, which have been activated in Camera 
Management. This way, it is possible to “lock” the live images and image playback for 
individual cameras in certain applications scenarios without having to remove these cam-
eras from the system.

The Next Camera and Camera Sequencer buttons also use the list of all cameras activated 
in the Camera Management. The sequence of the cameras in this list corresponds to the 
display sequence in the Camera Management and proceeds from top to bottom and left 
to right. You can change this sequence using drag and drop: If you move a camera image 
using the mouse and allow it to fall onto another position, these two cameras switch 
positions in the Camera Management and also in the Camera Overview.

For more details on working with the Next Camera and Camera Sequencer features, see 
Section 3.3, “Displaying Live Images And Monitoring Alarms”.
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Elements of the Camera Management:

Click the Camera Overview and Layouts button again to return to Standard mode.

Alarm Planner Mode (Calendar)

In this mode, you can define time periods for recording events for the current live camera in 
the main window. Activate this mode by clicking the Alarm Planner button. The live images 
of the current camera and up to three additional cameras are displayed in the image 
bar. Using the calendar displayed, you can define time periods, the events that trigger an 
alarm, the actions taken during recording and the type of recording to be used in case of 
an alarm. Here, you can also define time periods for continuous recording that is inde-
pendent of events. For more details, see Section 3.6, “Setting Up Alarms And Recordings”.

Activated cameras

Deactivated cameras
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Click the Alarm Planner button again to return to Standard mode.

Note

Double-click the live image in the top right-hand corner of the image bar to switch the 
positions of the live image and the calendar. The calendar is now displayed at the top 
of the image bar and the live image is displayed in the main window. Double-click 
the calendar again to return it to the main window. This feature can be helpful for 
defining video motion windows (see Section 3.6.5, “Selecting The Alarm Sensors”).
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3.2.3	 Size Of The Program Window

The Standard, Panorama, Overview and Player view modes described in Section 3.2.2, 
“Program View Modes”, are mainly controlling the layout and the format of the MxEasy 
display elements (main window, image bar). Besides the view modes, MxEasy features 
additional possibilities to control the size of the program window and its display windows.

These possibilities allows using the resolution of the monitor as efficiently as possible, for 
example. On the other hand, this means that the images may need to be scaled, resulting 
in reduced image quality as compared to the original image size or if the scaling factor 
is using “favorable” multiples.

For this reason, MxEasy offers an additional option to adjust the size of the program 
window in such a manner that the camera images are displayed in optimum quality. The 
following paragraphs will present the individual settings.

Program Window Modes

For all modes described above (except Alarm Planner), MxEasy can be switched to two 
special modes that optimize the available monitor space when displaying the camera in 
the main window or the Camera Overview. The View menu contains the Full Image and 
Maximize commands.

Full Image

These settings can also be activated or deactivated using the Full Image button. This 
command resizes the main window or the camera overview as well as the surrounding 
symbol bars to cover the entire screen; the image bar is not displayed in this mode. The 
frame of the program window and the Windows task bar are no longer visible. You can 
deactivate this mode by clicking the Full Image button again, by selecting the View > Full 
Image menu command, or by pressing the ESC key.

Maximize

The entire program window is expanded to fit the screen so that the main window or the 
Camera Overview are displayed with the toolbars. The frame of the program window 
with the title bar, the menu bar and the status bar and the Windows task bar remain 
visible. This mode can be deactivated by pressing the ESC key or the Minimize button in 
the Windows title bar.

Size Settings

Clicking on the Camera Overview and Layouts button or the menu command View > 
Layout opens an additional selection menu, which allows controlling the size of the dis-
play elements.

The adjustable sizes, VGA (640 px) to MEGA (1280 px), refer to the size of the main window. 
The size of the image bar is automatically adjusted to the new size of the main window.
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Note

Using a size setting that is identical to the size of the camera image will result in 
optimum image quality.

‘Original Size’ Setting

This option displays the unscaled live image of the current camera in the main window 
with the original image resolution from the camera. The main window sets the size of the 
image (VGA, SVGA, XGA or MEGA) so that it is either exactly the same size as the cam-
era image or slightly smaller. If the camera image is too large because, for example, the 
camera displays a QXGA image of 2,048 x 1,536 px or records at a resolution that does 
not correspond to the four available resolution settings, the main window will display a 
centered section of the image instead of the entire camera image. You can use the digital 
PTZ commands to view the edges of the image that are not visible in the main window. 
For more details, see Section 3.8, “Playing Back And Evaluating The Recordings”.

Caution

•	 When you select Original Size, MxEasy automatically starts its automatic size 
adjustment feature. Afterwards, this option is no longer displayed in the selec-
tion menu as the manual PTZ commands can also lead to the same state and 
can also chage this state afterwards.

•	 If the camera in the main window records images in Panorama mode (aspect 
ratio 8:3), MxEasy automatically activates the Panorama view (if you acknowl-
edged the user prompt).

‘Don’t Scale Up’ Setting

This option ensures that camera images that are smaller than the main window are not 
enlarged (scaled up). These images are displayed in their original size, centered in the 
main window. This option allows preventing images from being scaled up, which can 
result in reduced image quality.

‘Toolbar’ And ‘Image Bar’ Options

You can use the selection menu to hide and/or display the toolbars and the image bar.
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3.3	 Displaying Live Images And Monitoring Alarms

In order to display and monitor the live images of the cameras, MxEasy mainly uses the 
Standard and Panorama view modes. This section describes the settings that are available 
when using these view modes.

Activate the Speaker button to hear the audio channel of the live camera shown in the 
main window. Note that this is only possible if the camera microphone has been activated 
(see Section 5.2.2, “Audio Settings”). If the camera microphone has not been activated, 
MxEasy disables this button.

MxEasy displays an icon for the current Recording Target in 
the lower information bar of the main window. Hold the mouse 
pointer over the icon in the information bar to see the tool tip.

Date/time of the 
MxEasy computer

Event image in main 
window

Last event of the main 
camera

3 live cameras in 
image bar

Symbol for recording
Camera Name

Symbol for recording 
target

Date/time of the last event of the 
main camera

Live image of the main 
camera
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3.3.1	 Switching The Displayed Cameras

Use the mouse to drag the desired camera from the image bar into the main window (or 
double-click the desired camera) to display a different camera in the main window. The 
cameras then switch places.

Manually Cycling Through Cameras

In Standard mode, up to four live images can be 
displayed. In the Camera Overview, however, you 
can activate up to 16 cameras for live display. Using 
the Next Camera button, you can switch to the next 
camera in the list of activated cameras. MxEasy then 
removes the current camera from the main window 
and replaces it with the top camera in the image 
bar. The other two cameras in the image bar move upwards and a new camera from the 
list of activated cameras is added in the bottom position in the image bar.

Automatically Cycling Through Cameras

Click the Sequencer button to automate the process of switching to the next camera. This 
mode sets MxEasy to automatically switch to the next camera activated in the Camera 
Overview every five seconds. You can change this time interval under Tools > Preferences 
on the Behavior tab.

You can switch to the previous camera or the next camera before the set time interval 
has elapsed using the arrow keys on your keyboard (Ctrl+è or Ctrl+). You can stop 
or restart the automatic cycle through the images by pressing Ctrl+Spacebar. This gives 
you more time to review a suspicious situation, for example.

Note

Camera Sequence

The activated cameras will normally be displayed in the same sequence as they 
appear in the Camera Overview. If a camera in the main window is replaced by a 
camera in the image bar as described above, this will change the sequence accord-
ingly. Each change in the Camera Overview (activation or deactivation of cameras, 
switching the sequence of the cameras) changes the display sequence to match 
the current sequence in the Camera Overview.

3.3.2	 Alarm Display

If an alarm is detected, a flashing red lightning symbol is displayed in the image of the 
camera that triggered the alarm. This symbol is displayed until you acknowledge the 
alarm by clicking the image. This applies to both the main window and the image bar.
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You can define the precise reactions of the software in the case of an alarm under Tools > 
Preferences on the Behavior tab (see Section 4.8.2, “‘Connections’ Tab”).

For more information on alarms and alarm notifications, see Section 3.6, “Setting Up 
Alarms And Recordings”.

When you display an event by double-clicking or dragging the event from the image bar 
into the main window, MxEasy automatically switches to Player mode and displays the 
desired event in the main window. For more information on Player mode, see Section 3.8, 
“Playing Back And Evaluating The Recordings”.

Note

If the time displayed in the title bar of the main window is flashing, it means that 
the system time of the camera in the main window differs by more than 15 seconds 
from the system time of the computer. Make sure to synchronize the computer and 
the connected cameras using a time server. For additional information on this topic, 
see Section 5.2.5, “Time Settings”.

3.4	 The Most Important Camera Views And Image Settings

3.4.1	 Camera Views

You can select one of the views available for the selected MOBOTIX camera using the 
pop-up menu of the Image and Recording Formats button.

Camera Views (All Cameras except Hemispheric Models)

•	 Full Image: MxEasy displays the entire live camera image (without inset image).

•	 Lens distortion correction: MxEasy displays a portion of the live camera image with 
lens correction. This option is available when the camera configuration is adjusted 
accordingly.

•	 Picture in Picture: This option displays a small image from one camera sensor inset in 
the large image of the other. This setting is available on MOBOTIX Dual models only.

•	 Picture in Zoom: MxEasy displays a small version of the entire live camera image 
in the bottom right-hand corner of the large live camera image. This way, the entire 
image is visible even when the live image is zoomed.

•	 Event in Picture: MxEasy displays a small version of the latest event image in the 
bottom right-hand corner of the large live camera image.

For more information on the different views available for MOBOTIX cameras, see the 
General Image Settings section in the Software Manual.
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Camera Views (Hemispheric Models)

•	 Full Image: The entire (distorted) full image of the image sensor is displayed.

•	 Normal: A corrected image is displayed. This image can be panned and tilted. This 
is the factory default image setting for the Q camera models.

•	 Surround: MxEasy shows four image sections pointing to each of the four cardinal 
directions in the same view. You first need to specify which direction is North. All four 
views can be changed independently of each other using PTZ commands.

•	 Panorama: This displays the corrected image of an entire room (corrected 180° 
panorama) from the left to the right wall. This view is available for the wall-mounted 
MOBOTIX Q model only. The aspect ratio of this view is 8:3 (width to height).

•	 Double Panorama: A panorama view of the Northern half of the image is shown 
together with a panorama view of the Southern half of the image with an aspect 
ratio of 4:3 (width to height). This view is available for the ceiling-mounted MOBOTIX 
Q model only. Both partial views (North and South) can be changed independently 
of each other using PTZ commands.

•	 Panorama/Focus: This view is a combination of the Panorama view (8:3) and two 
smaller individual views (each 4:3) in a single image. This view is available for the 
wall-mounted MOBOTIX Hemispheric cameras.

Q24 view “Normal” Q24 view “Surround”

Zoomed image section Q24 view “Full Image”

For more information on the views available for MOBOTIX Hemispheric cameras, see 
the section First Images And The Most Important Settings In The Browser in the Camera 
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Manual. In addition, refer to the information in the section Setting Image And Recording 
Formats (the Recorded Image option) in the Camera Manual.

3.4.2	 Image Settings – Formats, Quality, Frame Rate, Hemispheric Settings, 
Recording

By clicking Image and Recording Formats, additional buttons for adjusting important 
properties appear along the bottom edge of the program window:

•	 Resolution: You can set the resolution of the camera image with this option. The 
resolution you set may be different from the resolution displayed in the main window 
of MxEasy. Regardless of the current resolution of the camera, the camera image in 
the main window of MxEasy is always displayed with the image size set here (VGA, 
SVGA, XGA or MEGA).

When you click this button, a magnifying glass appears in the camera image. Click 
the plus or minus (+/-) button of the magnifying glass to change the image resolu-
tion of the camera (the new image resolution will soon appear in the camera image). 
You can now move the magnifying glass to a new image area.

The section in the magnifying glass area always shows the original resolution of the 
camera (one pixel of the camera image will appear as one pixel on your monitor). 
This means that if the image resolution of the camera is set to a value higher than 
the resolution of the main window, the magnifying glass area will show an enlarged 
image (for example, 2 times or 4 times the size). This function allows you to accurately 
judge the image detail provided by the camera and used for the recording. You can 
optionally select the desired resolution in the context menu of the Resolution button.

•	 Custom Size: You can create a camera image with a custom resolution and size 
with this option. To do so, use your mouse to draw a box directly in the camera 
image. Windows set up in this manner will be automatically saved and activated 
once you deactivate this button.
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By clicking the Custom Size button again, you can readjust or delete the area that 
you have defined in the camera image. This area is also displayed at the correct 
position in the full camera image, which has been darkened. You can move this area 
with the mouse, change its size or delete it.

This function is useful if only certain areas of the camera image are allowed to be 
monitored, for example.

When monitoring pumps at a gas station, for example, it may be useful to resize 
the image to display only the horizontal strip in the middle that is of possible inter-
est. This way, the recorded images require less storage space. Compared to a full 
image, the resized image requires less bandwidth for live display and less storage 
space for recorded data.

•	 Image Quality: The three values that can be set using this button (Fast, Normal, 
High) influence the image quality in which the image sensor is to be read. Increasing 
the image quality improves the camera image but also decreases the maximum 
available frame rate ‑ for VGA resolution (640 x 480 px) and higher. The Normal 
option offers a good compromise between the High and Fast options. For more 
information, see the sections General Image Settings and Image Programs in the 
Software Manual.

•	 Obscure Area: If certain areas in the image are meant to remain unrecognizable, 
you can use this button to obscure these areas with the camera (for example, work-
stations, public areas, etc.). To do so, use your mouse to draw one or more boxes 
directly in the camera image. Windows set up in this manner will be automatically 
saved and activated once you deactivate this button.

•	 Camera Frame Rate: From the pop-up menu of this button (right-click), you can set 
the frame rate provided by a camera (options: No Limitation, 25 fps, 16 fps, 12 fps, 
8 fps, 4 fps). This function can be used as a way to manage bandwidth. The lower 
the frame rate, the less bandwidth is required to transfer the video data. Note, 
however, that you should primarily use the functions outlined in Section 4.5, “Bandwidth 
Management”.
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•	 Mounting Position: You can set the mounting position of a MOBOTIX Q model (Ceiling 
or Wall) from the pop-up menu of this button (right-click). If ceiling mounting is enabled, 
you can also specify the North direction of the camera. Activate the button and turn 
the image to the right or left using the symbols that appear. The North direction set 
in this manner will be saved automatically once you deactivate this button.

The defined North direction influences the Surround and Double Panorama camera 
views. In the Surround view, the image is composed of four partial images ‑ consist-
ing of views to the North, East, South and West. The Double Panorama displays two 
180° panorama views arranged vertically. One image is a view to the ‑ North, the 
other is a view to the South. For additional information, see the section First Images 
And The Most Important Settings in the Q24M Camera Manual.

•	 Recorded Image: This option is important for all cameras for which a zoomed sec-
tion of the live image (PTZ) is shown instead of the full camera image. This applies 
to all cameras that are digitally zoomed so that individual areas of the image can 
be monitored more closely, particularly hemispheric camera models (Q24M/Q24M). 
If a live image is recorded in this manner (option: Record Shown Image), the areas 
that are not visible in the zoomed image will also be missing from the recording. 
You can prevent this by selecting the Record Full Image option, which guarantees 
that a full camera image is always recorded ‑ regardless of the live image that is 
visible or its settings.

Note

When playing back video data, MxEasy can automatically correct the recorded 
(distorted) full images of Hemispheric cameras in the same views (Surround, 
Panorama, etc.) as are available for live images. In this case, the PTZ commands 
can be carried out after the image is recorded so that the user can inspect any 
areas of the image more closely during playback.

Note that any subsequent search of the full camera image (PTZ functions) is only 
possible with the Record Full Image option.

Q24M: Shown Image Q24M: Full Image

•	 Record Audio: If this button is activated, the audio from the camera microphone will 
be included in the recording. If the button is deactivated, the video sequences will 
be recorded without sound.
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Note

These settings apply for all recordings. You cannot make separate settings for each 
recording time period.

3.5	 Image Sections And Digital Zoom Functions (PTZ)

With MxEasy, you can use digital zoom to scale the displayed image up or down and 
pan the modified image area from side to side or tilt it up and down. These functions are 
called PTZ functions (Pan/Tilt/Zoom).

3.5.1	 Zooming The Image Section

You can use the following options to operate the zoom functions:

•	 Roll the mouse wheel forward in order to zoom in on the image. Roll the mouse 
wheel backward in order to zoom out from the image.

•	 Press and hold the Alt key (Windows) and use the mouse to draw a rectangle in the live 
image. MxEasy displays the selected image section in the main window.

Note

This zoom function is not available for the live image display of MOBOTIX 
Hemispheric cameras.

•	 Press and hold the Command key. Press the buttons  or  in order to scale the 
visible image section up or down. Ctrl+# shows the full image again.

•	 Rotate the control stick of the joystick to zoom in on or zoom out from the image.

Note

If you are using a joystick, make sure that you have properly configured it before 
you start MxEasy.
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3.5.2	 Panning And Tilting The Image Section

You can use the following features once you have defined an image section:

•	 Use the mouse to drag the zoomed image area in the desired direction.

•	 Press the arrow keys on the keyboard to drag the image section as desired.

•	 Move the joystick left, right, up or down to pan and tilt the image section as desired.

After you have defined the image section, you can save this view to be used later.

3.5.3	 Digital Zoom In MxEasy And In The Camera

A digital zoom of an image is carried out in two steps:

1. Application zoom:

Often, the camera records images with a higher resolution (e.g. MEGA 1280 x 960 px) 
than that of display in the MxEasy main window (e.g. VGA 640 x 480). In the display, 
multiple pixels are combined, reducing the size of the pixels. Note that the digital appli-
cation zoom is active now.

The software displays an arrow cursor over the live image. When 
you move the mouse or the joystick, the highlighted black arrows 
of the cursor indicate the direction in which the image is being 
moved.

In this case, a digital zoom causes the main window to display 
an image section instead of the entire camera image. This first step ‑ the “application 
zoom” ‑ is visualized by a small rectangle in the upper right-hand corner of the image. 
This visualization shows the displayed image within the entire camera image.

If you perform any panning or tilting commands while the image is zoomed, these motions 
will only affect the area inside the entire camera image. These motions also are visualized 
by the small rectangle.

As you continue to zoom, the application zoom is used until the selected section of the 
camera image is as large as possible in the main window (until the pixels are no longer 
reduced). The pixels will not be enlarged if you continue to zoom. Instead, the zoom func-
tion is taken over by the camera.

2. Camera zoom:

When zoom and PTZ commands are carried out inside the camera, 
the camera reads and displays a smaller section of the image 
sensor. This way, more pixels are available for displaying a smaller 
image section and more details are visible. The transition from application zoom to camera 
zoom and PTZ commands carried out by the camera is visualized in the upper right-hand 
corner of the image, this time by a camera symbol instead of a rectangle.
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Caution

The camera zoom is only available after it has been allowed by pressing the Toggle 
PTZ button. Otherwise, the application zoom is the only PTZ command that is carried 
out.

Notes

Digital application zoom and live stream:

Carrying out PTZ commands within the application zoom has no effect on the gener-
ated camera image and therefore no effect on the recording.

Camera zoom and live stream:

PTZ commands carried out within the camera change the live image of the camera 
also affect the recording if the camera does not record the full image. In order to 
select an image section within a zoomed image, press and hold the Alt key and 
use the mouse to draw a box within the live image. MxEasy displays the selected 
image section in the main window.

PTZ Views (Positions)

In addition to interactive PTZ controls using the mouse, keyboard or joystick, you can select 
areas of possible interest in the camera image along with the desired zoom, pan and tilt 
settings and save these settings as PTZ preset views. You can then activate these views 
at a later time with a click of the mouse.

Proceed as follows to save current image sections or PTZ preset views:

•	 Click the PTZ Views button to activate the preset view buttons in the dynamic toolbar:

•	 To save a view, click one of the numbered view buttons (for example, View 2) and 
hold down the mouse button (for about 3 seconds) until View 2 stored! appears in 
the main window. MxEasy now places a marker beneath the button to indicate that 
the view has been assigned.

The number keys on your computer can also be used to save preset views: When 
you press and hold down a number key (for example, 2), this view is saved (View 10 
is saved by pressing 0).

•	 If you would like to return to a saved view, briefly click the corresponding button or 
briefly press the corresponding key (for example, 2 for View 2). MxEasy displays the 
corresponding view. (View 10 can be activated by pressing 0.)
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•	 If you have a joystick with save buttons installed on your computer, you can also use 
these buttons to save frequently-used views.

You can use this feature to save up to ten preset views for each camera in your MOBOTIX 
system and activate them as needed.

Note

For MOBOTIX Hemispheric cameras with an L11 lens (360° allround view), you can 
select additional options in the pop-up menu of the Toggle PTZ button. These addi-
tional options are only available for hemispheric cameras. For more information, 
see the Configuring The MOBOTIX Q24M section in the Q24M Camera Manual.

3.6	 Setting Up Alarms And Recordings

You can centrally set up and manage recordings, alarms and notifications for one or more 
MOBOTIX cameras to be triggered for specified times and days of the week using MxEasy.

Note

All MOBOTIX cameras controlled by MxEasy can use different recording targets. 
Depending on the model and type of camera used, they can store the audio/video 
data on internal storage media (SD cards) or on file servers.

Newer cameras (Q22M, Q24M, D24M, M24M, all except Basic and Web models) and 
R models have factory-installed SD cards and are preconfigured for recording “out-
of-the-box”. At present, MxEasy cannot change the recording target of the cameras. 
To change this basic configuration setting, you need to change the configuration on 
the camera itself (see Section 4.7, “Recording Targets ‑ SD Cards And File Servers”). 
This section also contains more information on the different recording targets.

3.6.1	 Operation Modes Of MxEasy

You can switch recordings/alarms on and off and activate the Alarm Planner as needed 
using Operation Mode. You can adjust these settings by clicking the Operation Mode 
button or by using the button’s pop-up menu:

•	 Switched Off Mode: Recordings, alarms and notifications are not activated. The time 
periods set up in the Alarm Planner (see below) are not taken into account.

•	 Alarm Planner: Recordings, alarms and notifications take place according to the 
weekly times and dates that have been set in the Alarm Planner (see below).

•	 Alert Mode: As in Alarm Planner mode, but recording takes place continuously with 
the maximum frame rate (continuous recording). This overrides the type of recording 
and recording times set up in the Alarm Planner.
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This setting remains active until it is manually changed.

Triggering Manual Alarms

When you click on the Manual Alarm button, MxEasy immediately activates continuous 
recording on all attached cameras for a limited amount of time. After this time has elapsed, 
MxEasy automatically switches back to the operation mode (see above) that had been 
active before. Note that this button also triggers all alarm notifications of the camera in 
the main window!

This feature is ideal for creating suspicion recordings, for example: As soon as security 
staff observes a suspicious situation, they can activate the manual alarm and continue to 
monitor the scene. If the suspicion is substantiated, security staff can extend the recording 
by five minutes by clicking on the button again. Once these additional five minutes have 
passed, recording stops automatically (unless it is extended again by pressing on the 
button once more).

Complete System Shutoff  – Privacy Mode

Use the Privacy Mode, if you would like to deactivate the whole system, i.e. recording 
and any kind of camera access is rendered impossible until you deactivate this mode. 
While this lock can be deactivated directly from the current computer, you will need the 
user name and password set in this dialog to deactivate the lock from a different computer 
(see Section 3.7, “System Shutoff ‑ Privacy Mode”).

3.6.2	 Alarm Planner

The Alarm Planner can only be activated in Standard mode ‑ using the Alarm Planner 
button or the Camera > Alarm Planner menu command. The live image of the camera 
from the main window is displayed as a small image in the top right-hand corner in the 
image bar and the other camera images move down in the image bar. All settings made 
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in the Alarm Planner apply to the camera that was previously in the main window. To 
change this, you may select the To All Cameras option.

The Alarm Planner allows you to set up recording modes, alarms and notifications for one 
or more cameras according to time and date settings in just a few steps.

Step 1:

•	 Set time period

Step 2 – for every time period:

•	 Select a recording mode

•	 Select alarm sensors to trigger alarms in the defined time periods

•	 Set alarm notifications

The following sections describe the individual setting options in more detail.

3.6.3	 Setting Time Periods

Use the mouse to draw a window in the calendar field to set a time period in the Alarm 
Planner. You can continue to adjust all settings of the time window after it has been created.

•	 Creating time periods: Use your mouse to draw a box inside the calendar window 
(see figure above) to create a new time period.

•	 Moving time periods: Use the mouse to drag the window to the desired time and 
day of the week to move a time period. A hand cursor appears automatically when 
the mouse pointer hovers over a time window.

•	 Changing time periods: If you want to shrink or enlarge a time period, drag the 
edge of the time window accordingly using the mouse. A resize cursor appears 
automatically when the mouse pointer hovers over the edge of the window. You can 
also use the weekday and time fields (in the lower section of the time planner) to 
adjust the active time period down to the minute.
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•	 Deleting time periods: Select the window with the mouse and press the Delete key 
on the keyboard (or right-click the time period and choose Remove in the pop-up 
menu) to delete a time period.

•	 “Background” time period: The areas that are not assigned to specific time periods 
(times and days) fall into a collective time period. This period can also be assigned a 
particular recording mode, alarm sensors and alarm notifications. Right-click outside 
a defined time period in the calendar field and make the desired settings using the 
pop-up menu (see following sections).

Hint

Make the settings for the “background” time period first. Then configure the indi-
vidual time periods.

Important

Selecting Time Periods

The settings for recording mode, alarm sensors and alarm notification described in 
the following sections always apply to the time periods that are currently selected. 
At least one time period is selected at all times: one or more explicitly defined time 
periods or the background time period. You can select multiple time periods by click-
ing these areas while pressing down the Command key. You can determine whether 
or not areas are selected by noting their color: selected time periods are darker.

3.6.4	 Setting The Recording Mode

You can set up a continuous or event recording using the pop-up menu of the time period 
(right-click the time period). If you have activated a time window in the Alarm Planner, you 
can also set up the recording mode for this window using the pop-up menu of the button 
(right-click the button).

The camera continuously records data for continuous recording and for event record-
ing, the camera begins recording when an alarm sensor is triggered (see Section 3.6.5, 
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“Selecting The Alarm Sensors”). The time period will be colored either red (continuous 
recording) or yellow (event recording) depending on the recording mode you have selected.

If event recording is selected, you need to also select at least one alarm sensor for the 
corresponding time period. Event recording is activated when the alarm sensor is triggered 
(see Section 3.6.5, “Selecting The Alarm Sensors”).

The recording status is indicated by the colored camera symbol in MxEasy (on the left in 
the blue camera information bar above the main window).

Recording off

Deactivated by camera time table

Waiting for events

Recording on

For more information on the recording features of the MOBOTIX camera, see Chapter 8, 
Recording, in the Software Manual.

Note

A period of two seconds before the beginning of the event is saved automatically 
along with the event for event recording.

3.6.5	 Selecting The Alarm Sensors

When the Alarm Sensor of the MOBOTIX camera (or the active connected CamIO or ExtIO) 
is triggered, event recording and/or alarm notification are activated (see Section 3.6.4, 
“Setting The Recording Mode” and Section 3.6.6, “Setting Up Alarm Notifications”).

You can set up alarm sensors using the pop-up menu of the time period (right-click the time 
period). You can also set the alarm sensors using the pop-up menu of the corresponding 
button (right-click the button).

•	 Video Motion Detection: The alarm is triggered when a MOBOTIX camera detects 
a VM event. The MOBOTIX camera uses video motion windows to detect changes 
in the live camera image. You can select a predefined set of video motion windows 
from the pop-up menu of this button. You can specify whether or not the window 
will be visible in the camera image with the Show Video Motion Windows option. 
This option can be used to check the windows and create user-defined windows 
(see below).

For more information, see Defining Video Motion Windows later on in this section.

•	 Passive Infrared Detection: The alarm is triggered when a PI event is triggered in a 
MOBOTIX camera. MOBOTIX cameras of the model series M12 and D12 are equipped 
with a PIR sensor (Passive Infrared Sensor) as standard. M24M and D24M models 
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can use the PIR of a connected MOBOTIX ExtIO. The PIR sensor enables motion 
detection even in the dark.

You can set different values for the triggering threshold using the selection menu 
of this button. Selecting a lower threshold value results in a higher sensitivity for 
triggering the PI event.

•	 Microphone (for Noise Detection): The alarm is triggered when a MI event is trig-
gered in a MOBOTIX camera. This event can be triggered either by the built-in cam-
era microphone or the microphone of an active connected CamIO or ExtIO.

You can set different values for the triggering threshold using the selection menu 
of this button. Selecting a lower threshold value results in a higher sensitivity for 
triggering the MI event.

•	 Signal Input Detection: The alarm is triggered when a SI event is triggered in a 
MOBOTIX camera. This event can be triggered either by the signal input of the 
MOBOTIX camera or by an active connected CamIO or ExtIO.

Using the selection menu of the signal input button, you can select a status or a 
status transition to trigger an SI event.

•	 Temperature Detection: The alarm is triggered when a TP event is triggered by the 
internal temperature sensors of a MOBOTIX camera.

Using the selection menu of the button, you can choose between different conditions, 
i.e. temperature ranges, that trigger an event.

•	 Illumination Detection: The alarm is triggered when an IL event is triggered in a 
MOBOTIX camera.

Using the selection menu of this button, you can choose between two different 
ranges that trigger an event.

For additional information, see the section Events in the Software Manual.

Defining Video Motion Windows

If you click the Video Motion Detection button while a time period is activated in the 
calendar view, MxEasy automatically displays the live image of the camera. The calendar 
is displayed in the top right-hand corner in the image bar.
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In this view, MxEasy displays predefined standard video motion windows (red areas such 
as in the image to the right). You can select additional video motion windows using the 
selection menu of the Video Motion Detection button.

The Custom Windows option in the selection menu allows you to create and edit custom 
video motion windows using the mouse:

•	 Creating video motion windows: Use your 
mouse to draw a box inside the camera image 
in the main window (see figure) to create a 
new window.

•	 Moving video motion windows: To move a 
window, drag and drop it to the location you 
want with your mouse. A hand cursor appears 
automatically when the mouse pointer hov-
ers over a window.

•	 Resizing video motion windows: Drag the edge of the window using your mouse 
to increase or decrease the size of a window. A resize cursor appears automatically 
when the mouse pointer hovers over the edge of the window.

•	 Deleting video motion windows: To delete a window, click the X button in the upper 
right-hand corner of the window or press the Delete key on your keyboard.

Defining Reference Windows

Reference windows help avoid false alarms result-
ing from unwanted changes in the image. The 
bright light from a flash during a thunderstorm, for 
example, instantly changes all image pixels. Such 
a change would normally trigger the defined video 
motion windows and, subsequently, the alarm.

Reference windows can help avoid most of these 
false alarms as the camera will not throw an 
alarm if both the video motion windows and 
the reference windows trigger simultaneously.

Hints For Defining Reference Windows

•	 Keep the Alt key pressed and draw a box with the mouse to define a reference 
window.

•	 One reference window per camera is usually sufficient.

•	 Always define reference windows in image areas that usually do not change, i.e. 
next to windows or in areas that are higher up and not reachable.

•	 Make sure that reference windows do not overlap video motion windows.

Once you have defined the reference windows, you can use the same functions for chang-
ing these windows as for video motion windows (moving, resizing, deleting).
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Again Displaying The Calendar In The Main Window

Double-click the camera image at the top of the image bar to display the calendar in 
the main window.

If at any time you wish to edit or resize the active video motion windows, you can switch 
the positions of the calendar and the live image so that the live image is displayed in the 
main window. To do this, double-click the Video Motion Detection button or double-click 
the live image in the top right-hand corner in the image bar.

Notes

•	 Custom video motion windows and reference windows are used for all time 
ranges, for which they have been activated. In contrast, you can set the pre-
defined windows for each time range individually.

•	 Video motion and reference windows of Hemispheric cameras and cameras 
with activated distortion correction are shown as polygons if the visible image 
has been panned, tilted or the image has been switched from Normal to Full 
Image, for example.

3.6.6	 Setting Up Alarm Notifications

Alarm Notifications can be sent when the alarm sensor of the MOBOTIX camera (or the 
active connected CamIO or ExtIO) is triggered (see Section 3.6.5, “Selecting The Alarm 
Sensors”).

You can set up and activate alarm notifications using the pop-up menu of the time period 
(right-click the time period). If you have activated a time window in the Alarm Planner, you 
can also set up alarm notifications for this window using the pop-up menu of the button 
(right-click the button).
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You must select at least one alarm sensor for the corresponding time period (see Section 3.6.5, 
“Selecting The Alarm Sensors”). The selected alarm notifications are sent when the alarm 
sensor is triggered.

•	 Sound Notification (audio playback): Click this button to activate playback of an 
audio file on the speaker of the MOBOTIX camera (or an active connected CamIO or 
ExtIO). Click the button a second time to deactivate the feature.

This function can, for example, play a pre-recorded audio file over the camera loud-
speaker to inform a suspicious person that he or she is being observed and recorded 
(“You are unauthorized to enter this area! You are under video surveillance. Please 
leave the premises immediately!”)

•	 VoIP Phone Notification: Click this button to activate VoIP phone notification from 
the MOBOTIX camera. Click the button a second time to deactivate the feature. This 
function can be used to alert the security guard that there is an alarm situation (for 
example, motion is detected in an office building at night). A message can be trans-
mitted via telephone (“Message from surveillance camera 15, office 32, 4th floor: 
Motion has been detected in this room.”)

•	 E-Mail Notification: Click this button to activate e-mail notification from the MOBOTIX 
camera. Click the button a second time to deactivate the feature.

This function can be used to document incoming vehicles in a corporate parking lot 
for later evaluation. E-mails are better for messages that do not require immediate 
action. This function makes it possible to send images via e-mail even if no recording 
medium is available (for example, an external data server).

Specific settings are necessary for each notification mode, for example, the name of the 
audio file, a phone number, an e-mail address and/or additional basic settings of the 
MOBOTIX camera. MxEasy detects whether valid settings have been made and if neces-
sary, it prompts you to make the necessary settings. For more information on camera 
settings, see Section 5.2.2, “Audio Settings” and Section 5.2.7, “E-Mail Settings”.

You can reselect an audio file, a telephone number or an e-mail address that was set 
previously using the pop-up menu of one of the time periods or the corresponding but-
ton (right-click the time period and select Edit or click the button on the lower edge of the 
MxEasy program window).

For additional information, see the section Actions And Messages in the Software Manual.

3.6.7	 Assigning Settings To One Or More Cameras

1.	 Activate the camera that is to be assigned a particular task. The active camera is 
always the camera displaying the live image in the small camera window in the 
upper right-hand corner of the Alarm Planner.

2.	 Click the Next Camera button until the desired camera is located in the upper 
right-hand camera window.
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3.	 Assign the camera to the desired time periods with the corresponding notification 
characteristics.

4.	 Activate the settings for the camera by clicking Apply. Activate the To All Cameras 
checkbox and then click Apply to simultaneously assign all cameras to the same 
time period.

Hint

First carry out the settings that apply to all cameras (the To All Cameras checkbox, 
for example, activation and recording) and then carry out the settings for the indi-
vidual cameras.

3.7	 System Shutoff ‑ Privacy Mode

In contrast to the other operation modes of MxEasy (see Section 3.6.1, “Operation Modes 
Of MxEasy”, the Privacy Mode deactivates the whole system, i.e. recording and any kind 
of camera access is rendered impossible until you deactivate this mode. While this lock 
can be deactivated directly from this computer, you will need the user name and password 
set in this dialog to deactivate the lock from a different computer. Note that the cameras 
are also signaling this operating mode by a specific LED blinking pattern.

Activating The Privacy Mode

To activate this mode of MxEasy, simply click on 
the Privacy Mode button. MxEasy now shows a 
dialog with the automatically generated access 
data. You can either use this access data or set 
a user name and password of your own.

Activate the Don’t ask me again checkbox if 
you would like to activate this mode immediately 
when clicking on the Privacy Mode button (i.e. the 
message box will not appear any more). MxEasy 
then creates new access data and activates the 
Privacy Mode without asking back.
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Caution

•	 Every time you are activating the Privacy Mode, MxEasy will generate new 
access data. Writing down these access data only makes sense if you would 
like to deactivate this mode from a different computer. In this case, you should 
never activate the Don't ask me again checkbox!

•	 If you choose not to see the generated access data, you can only deactivate 
the Privacy Mode from the same computer. In case of a serious malfunction (or 
total failure) of this computer, you can activate the system again as described 
in Section 5.7, “Resetting The Cameras From The Privacy Mode”.

Effects Of The Privacy Mode

•	 MxEasy generates random access data (user name and password), sends them 
to the attached cameras and deactivates all other users. If you do not posses the 
access data, you can only deactivate this mode from the same computer that had 
been used to activate the Privacy Mode.

•	 Image generation is deactivated completely ‑all display windows show the red lock 
icon. The Privacy Mode button itself is now white and the lock is closed.

•	 Recording is completely deactivated.

•	 The camera’s audio channel is switched off completely.

•	 All attached cameras show a distinctive blinking pattern so you can see that the 
cameras are in this mode (see below).

Signaling By The Camera LEDs

The different MOBOTIX cameras are displaying the following blinking patterns once they 
have been switched to Privacy Mode.
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Camera LEDs Blinking Pattern

M12
LED 0 flashes every 3 sec. red 
LED 3 flashes every 3 sec. red, in sync with 
LED 0

D12
LED 0 flashes every 3 sec. red 
LED 3 flashes every 3 sec. red, in sync with 
LED 0

Q22M, D22M, 
M22M

LED 0 flashes every 3 sec. green 
LED 1 flashes every 3 sec. red, in sync with 
LED 0

Q24M, D24M, 
M24M

LED 0 flashes every 3 sec. green 
LED 1 flashes every 3 sec. green, in sync with 
LED 0

Deactivating The Privacy Mode

Simply click on the Privacy Mode button if you are using the same computer and you 
would like to deactivate this mode and switch on the system again.

If you are running MxEasy from a different computer, enter the access data that you have 
written down or defined yourself upon activating the mode.
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3.8	 Playing Back And Evaluating The Recordings

You can play back and evaluate the recorded event sequences (video and audio) of the 
MOBOTIX cameras using the MxEasy Player. Once you have activated Player mode by 
pressing Player Mode, a recorded image takes the place of the live image in the main 
window. The live image of the camera is then displayed at the bottom right-hand corner 
in the image bar.

When you launch the Player for the first time, the most recent event image of the camera 
is displayed automatically. When the Player is launched again, it automatically displays 
the image from the point in time at which it was last deactivated. If the Player was last 
launched for a different camera and the current camera does not have a recording that 
corresponds to the correct time, the Player displays the next available image in the record-
ing.

The Player buttons are used to play back the recorded event sequences. The Video Search 
button provides you with the search tools you need to quickly find the events you are 
looking for.

When you click any of the buttons marked with a red lightning, the software plays back 
the event images only. Buttons without a red lightning play back all recorded video and 
audio data. This includes the images that were recorded prior to and after the event.

Playing Video Sequences

•	 Play: Click this button to play back all recorded video and audio data.

•	 Fast Forward / Fast Backward: These buttons play back the recorded video and 
audio data quickly (in fast motion).

•	 Play Events / Play Events Backward: These buttons play back the recorded event 
images (without the time periods recorded prior to or after the events).
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Positioning Within The Recordings

•	 First Event / Last Event: These buttons jump to the first or last image of the recording 
respectively.

•	 Previous Event / Next Event: These buttons jump to the next or previous event image 
respectively.

If the recording contains audio data, you can press the Speaker button to play back the 
audio data. The recorded audio data from the camera can be played only with normal 
playback (Play button). Audio data cannot be played with other types of playback (Fast 
Forward, etc.)

Procedure For Evaluating And Exporting Recordings

We recommend the following procedure for evaluating recordings, viewing event sequences 
and preparing recordings for export (the Search Event button):

1.	 Enter the earliest time for which you would like to begin the evaluation.

2.	 Watch the events image for image for a quick overview of the recordings.

3.	 If you would like to have a closer look at a particular event, play back the recorded 
video sequence in real-time with audio.

4.	 Move the red triangle to take a look at the video at various spots within the recorded 
event sequences. The date and time of the current event are displayed in the 
upper section of the dialog.

5.	 Set the start and end positions of the time period to be exported using the blue triangles.

6.	 Press Add Clip to Export List to add the clip marked by the triangles to the MxEasy 
export list. From here, this clip can by saved to a computer or an external storage device.

For more information on the export functions of MxEasy, see Section 4.1.3, “Exporting 
Video And Audio Data”.
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3.9	 Creating Users And Passwords

You will have access to all functions and authorizations 
(automatic administrator mode) the first time you launch 
MxEasy. If you would like to set up the software to limit 
user access to certain functions, we recommend using 
the predefined MxEasy access levels (Administrator, 
Owner, User, Guest). Specific functions are automati-
cally preassigned to each access level.

Once you have set up a password for a particular access 
level, it is activated automatically (the access level Guest 
can be accessed without entering a password). Please 
note that passwords can only be set up in the Administrator 
access level.

You can log on to the access level using the login dialog 
(the Authenticate button or the menu command File > 
Authenticate). As long as the Administrator access level 
is activated, this dialog also displays the buttons for set-
ting up and changing an existing password (Change 
Password).

The active access level is indicated by the red stars on the button:

•	 Administrator: You have access to all functions and settings of MxEasy with the 
Administrator access level. In particular, this allows you to add new cameras to 
MxEasy and remove existing cameras from the software. This access level is the only 
one that allows you to set up and change passwords.

•	 Owner: You have access to all functions available for the User access level and to 
the majority of the remaining MxEasy functions in this access level.

•	 User: You have access to the recorded event sequences in addition to the functions 
available for the Guest access level.

•	 Guest: You can access live views of all cameras and save snapshots with this access 
level.

Notes

For an overview of the functions in the individual access levels, see Appendix B, 
“Access Rights For User Access Levels”.

Automatic Authentication On Launch

If you have set up passwords for the access levels, each time you launch MxEasy you need 
to select the access level and enter the correct password. If you would like to be logged 
on automatically, you can activate this option and select the relevant access level under  
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Tools > Preferences > General. MxEasy then automatically logs on to this access level 
without prompting you to enter a password (see Section 4.8, “Adjusting The Default Program 
Settings”).

You can change the access level by clicking Authenticate while the software is running. 
To do so, select the access level in the menu and confirm your selection by entering the 
correct password. If needed, the administrator can activate additional functions by select-
ing a different access level. After the settings have been made, you can return to the Guest 
access level using the same dialog.
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Notes:



70/132 MxEasy User Manual: Advanced Operation

© MOBOTIX AG  •  Security-Vision-Systems  •  Made in Germany

www.mobotix.com  •  sales@mobotix.com

4	 Advanced Operation
In Chapter 3, “Getting Started”, you learned about the basic features of MxEasy. Note, 
however, that MxEasy allows you to do much more than simply play back video sequences. 
In this chapter, we will familiarize you with the advanced features of this software.

4.1	 Saving, Printing And Exporting

4.1.1	 Saving Snapshots

The easiest way to take snapshots is to click the Snapshot button. When you click this but-
ton, the image from the camera displayed in the main window will be saved immediately 
as a *.jpg file. This works for both live images and event images. The file name of a file 
saved as *.jpg contains the name of the camera followed by the date and time of the 
recording (for example, mxcam 2008-11-24 15-05-13 for a file saved on November 
24, 2008 at 3:05 PM and 13 seconds). The file names allow you to sort the files more easily.

Note

You can specify a target folder for the saved images under Tools > Preferences on 
the General tab (Snapshots > Folder).

4.1.2	 Printing Snapshots

You can print a camera image in MxEasy using the Print button. This feature is only acti-
vated in Normal mode and Player mode. In Normal mode, the live images of the current 
camera are printed – in Player mode, the latest event image of the camera in the main 
window is printed together with the live images of the other cameras. A print preview is 
always displayed before the image is printed. Here, you can set the format, zoom factor 
and number of images per page.
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4.1.3	 Exporting Video And Audio Data

In order to export recorded audio/video data, you need a MOBOTIX camera with at least 
one recording. If the Player button is active (i.e. not grayed out), you can click on this but-
ton (it turns white) to see the last event image.

Before you start exporting recorded audio/video data, you should briefly consider how 
these data will be used later on. Generally speaking, you can create the following formats 
when exporting:

•	 File server structure: JPEG images for playback using MxEasy or MxControlCenter.

•	 MxPEG Clip: MOBOTIX format for playback in MxEasy, MxControlCenter and in 
Windows Media Player (after installing the MxPEG DirectShow codec).

•	 AVI file: When using this format, you should use a suitable codec depending on the 
target operating system. In order to find the suitable export format, you should read 
Section 4.1.5, “Playing Back Exported Audio/Video Data”.

Select the Video Search button in Player mode to export recorded video sequences from 
MxEasy:

When this button is activated, the Select Event by Time dialog appears:

You have the following options for selecting the correct position in the recording:

•	 Move the red triangle on the slider bar in the main window.

•	 Move the red triangle on the slider bar in the Select Event by Time dialog.

•	 Enter and confirm (using the Enter key) the desired time in the Select Event by 
Time dialog.
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To export recorded video and audio data:

1.	 Select the start time of the sequence you want to export. You can do so by moving 
the blue triangle on the left or entering a time in the Date/Time field (for example, 
using the arrow keys) and then clicking the Set Start Marker button.

2.	 Select the end time of the sequence you want to export. You can do so by moving 
the blue triangle on the right or entering a time in the Date/Time field (for example, 
using the arrow keys) and then clicking the Set End Marker button.

3.	 Click the Add Clip to Export List button. The Export dialog will now open with the 
time range you selected. Previously selected time ranges may appear and can, 
if necessary, be removed manually (Del key). If you have closed the list by accident,  
you can open it again by selecting File > Export Recordings from the menu.

4.	 Select the desired export format:

–	 File Server Structure: This option allows you to export the recorded data of the 
selected time range in the same format in which it is saved in the file system. 
Unlike other options, this option does not convert the format and hence requires 
the least amount of time to export. We recommend using this option when you 
need to keep the files in their original format (for example, to preserve evidence 
for law enforcement purposes).

–	 MxPEG Clip(s): With this option, the recorded data of the selected time period is 
exported as MxPEG clip files. Files in MxPEG format also include the audio data 
recorded by the camera.

The max. file size for exporting can be set using the Settings button.

–	 AVI clips: Use this option to export (recode) the event sequences of the selected 
time range as AVI file. The audio track can be included, if this is desired. Depending 
on the video codec used, you can play back the AVI file on different operating 
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systems using different applications (see Section 4.1.5, “Playing Back Exported 
Audio/Video Data”.

Note

MxEasy can play back data server structures and MxPEG clips. You can do 
this in the dialog located under File > Open Clip (see Section 3.8, “Playing 
Back And Evaluating The Recordings”).

5.	 Select the export settings (using the Settings button). You can now specify differ-
ent options for the export, including a file size limit as well as audio and video 
encoding options with which you can define parameters such as the resolution 
or video codec.

6.	 To start the export, click Export.

The time required for the export to fin-
ish depends on a number of factors, 
including the processing speed of your 
computer, length of the selected time 
range, number and size of individual files 
and type of recording (event or continu-
ous recording). In particular, converting 
to an *.avi file can take a long time.

4.1.4	 Export Options

When exporting the audio/video data, you can choose between different options depend-
ing on the export format selected in the Export dialog (MxPEG clips/AVI clips). Note that 
File server structure does not allow selecting any options. The preselected options pro-
vide for maximum compatibility of the exported data on the different operating systems 
(Windows, Mac OS X, Linux).

File Size

This tab allows setting the maximum size of 
the individual files. If the data are larger than 
specified here, MxEasy automatically creates 
additional files with the same name and a run-
ning number.

You can set most of these options for MxPEG 
clips and AVI clips.
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Audio

You should only change this setting if there is a 
good reason to use a different codec than the 
default PCM codec.

This tab is only available for AVI clips.

AVI

You should only change these settings if you 
have special requirements (e.g. if you need to 
set a specific resolution or frame rate).

Selecting the codec has a significant impact on 
the operating system on which you can play 
back the exported data:

•	 Motion JPEG: This codec stores full JPEG 
images and is suitable for most common 
operating systems. The exported data have 
the highest quality, since they consist of 
the original camera images stored as full 
JPEG images, but this codec requires the highest storage capacity (4 to 6 times as 
compared to the FFMPEG MPEG-4 codec).

•	 FFMPEG MPEG-4 (default): The preselected codec is supported by VLC and can also 
be played back on Windows, Mac OS X and Linux operating systems, if you need 
to support other players than VLC. This codec represents the ideal combination of 
quality and minimum storage space.

•	 Microsoft MPEG-4 V2: General-purpose codec for Windows systems.

•	 DivX V3 MPEG-4 (Low Motion): This codec is available for all operating systems 
free-of-charge (www.divx.com).

•	 Windows Media Video 7: Version 7 of the standard codec for Windows systems, 
which can be played back using Windows Media Player.

•	 Windows Media Video 8: Version 8 of the standard codec for Windows systems, 
which can be played back using Windows Media Player.

If the Display recording gaps checkbox has been activated, the end timestamp of the 
last clip and the start timestamp of the next clip will be shown for ten seconds, provided 
that the gap is ten seconds or longer.

This tab is only available for AVI clips.
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4.1.5	 Playing Back Exported Audio/Video Data

You can play back exported MxPEG clips and file server structures directly in MxEasy 
(File > Open Clip > ...). Note that you can also use MxControlCenter to play back these 
export formats. After installing the MxPEG DirectShow codec, you can also play back 
MxPEG clips in Windows Media Player and other DirectShow-enabled applications (you 
can download the codec free-of-charge from www.mobotix.com in the Support > 
Software Downloads section).

In general, the exported AVI files can only be played back on the standard players that 
come with the operating systems. If you would like to use a universal player that can play 
back all of these formats on all operating systems, you should install the VideoLAN player 
(VLC, www.videolan.org). It can play back AVI files exported with the preselected 
options and also with all other codecs. Note that the files are automatically added to the 
playlist of VLC and the other players in order to play them back automatically one by one.

The following table shows which preinstalled or installable video players can be used on 
which operating system in order to get the best quality when playing back the audio/
video data:

Windows Mac OS X Linux

Codec VLC
Windows 

Media 
Player

VLC QuickTime VLC
MPlayer, 
Xine, ...

Motion JPEG +++† +++† +++† +++† +++† +++†

MxPEG DirectShow — +++** — — — —

FFMPEG MPEG-4 ++ ++* ++ ++* ++ ++*

Microsoft MPEG-4 V2 + + + — + +*

DivX V3 MPEG-4 + +* + +* + +*

Windows Media Video 7 + + + — + +*

Windows Media Video 8 + + + — + +*

Quality/compatibility: +++ excellent, ++ very good, + good, o satisfactory, — not possible;	  
Remarks: * codec to be installed separately, ** MxPEG DirectShow codec to be installed separately, † high storage 
capacity required
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4.2	 Saving And Restoring Settings

The backup feature (the Backup Configuration button), allows you to save and restore 
all MxEasy settings and the complete configuration of each connected camera with a 
simple click of the mouse.

Caution

After you have finished setting up the system, after changing the configuration and 
especially after adding cameras, it is highly recommended to store the contents 
of the backup folder (see Section 4.2.2, “Storing The Backup Folder”).

4.2.1	 Creating And Loading Backups

MxEasy automatically creates a backup when you start the program. You can also click 
the Create Backup button if you need to create one manually.

Loading A Backup

You can specify the time when a backup will be loaded using the following functions:

•	 Initial default configuration: This backup allows restoring all cameras and MxEasy 
itself to the default settings that were set when the program was first launched and 
the cameras were integrated into the system by MxEasy Wizard.

•	 Most recent startup of application: This backup contains the configuration data of 
MxEasy from the last time it was launched.

•	 Yesterday: This backup contains the configuration data of MxEasy when it was first 
launched on the previous day.

•	 One week ago: With this option you can load the configuration data of a backup 
from the previous week or earlier.
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•	 Manual backup from: You can select a manual backup from the list provided. If 
you have already created manual backup, you can delete the most recent backup 
or all manual backups.

Once you have selected a backup, MxEasy uploads the backup to the attached cameras 
when you click on the Reset button and restarts the cameras.

Caution

The configuration backup only covers the cameras currently attached to MxEasy. If 
you have changed the configuration or added new cameras, it is strongly recom-
mended to create a manual backup (see Section 4.2.2, “Storing The Backup Folder”).

4.2.2	 Storing The Backup Folder

After you have set up the system or changed the configuration, you should create a 
manual backup. In addition, you should copy the entire backup folder to a separate stor-
age device. This will allow you to easily restore the configuration in case you should have 
problems with this computer.

•	 Click on the Configuration Backups button.

•	 Create a manual backup by clicking on Create Backup (you should add the text 
“Manual” at the beginning of the backup name so you can identify the manual 
backups easier later on).

•	 Click on the magnifying glass icon to open the backup folder.

•	 Copy the entire contents of the folder to a suitable external storage device (possibly 
as a ZIP archive of the folder).

4.2.3	 Replacing The Backup Folder

•	 Click on the magnifying glass icon to open the backup folder.

•	 Make a backup copy of the entire contents of the folder (possibly as a ZIP archive 
of the folder).

•	 Delete the entire contents of the backup folder.

•	 Copy the entire contents of the stored folder into the backup folder.

•	 Close MxEasy and restart the application.

•	 Click on the Configuration Backups button.

•	 Activate the Manual backup from option and select the backup you created manually.
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•	 Click on Reset and then on OK in the confirmation dialog.

MxEasy uploads the configuration to the currently attached cameras and restarts them.

4.3	 Using The Door Intercom

The IT and Secure models of the M12 and D12 MOBOTIX cameras and the ExtIO and 
CamIO expansion models that are compatible with all MOBOTIX IT and Secure models 
are equipped with signal inputs and outputs. The signal inputs are capable of receiving a 
doorbell signal, for example, and the signal outputs can transmit the command to open 
a door (or a gate) to a locking system (door opener).

This means that MxEasy, when used in conjunction with MOBOTIX cameras, can serve as 
a fully equipped and flexible door intercom system with video and audio transmission. 
Press the Microphone or Loudspeaker button to use the intercom (audio transmission). 
To open a door or turn on the light, press the Door or Light button. You can also play 
back a voice message that has been saved in a MOBOTIX camera (the Sound button).

•	 Microphone: The audio from the computer microphone will be transmitted to the 
camera loudspeaker for as long as you press and hold this button. This works the 
same way as if you were to make an announcement in a soccer stadium or on a 
train platform or to use a handheld transceiver or a door intercom.

•	 Speaker: Activate this button to hear the audio from the camera microphone over 
the computer loudspeakers. This feature allows you to use MxEasy as a door inter-
com, for example.

•	 Door: You can activate a door opener connected to a MOBOTIX camera (or a con-
nected ExtIO or CamIO) with this button via signal output 1. The signal output/door 
opener will deactivate automatically after five seconds.

•	 Light: This button allows you to enable and disable a device (for example, the light 
for the door intercom) connected to a MOBOTIX camera (or a connected ExtIO or 
CamIO) via signal output 2.

•	 Sound: Click this button to play back an audio file that has been saved in a MOBOTIX 
camera on the loudspeaker of that camera. You can select one of the audio files that 
is available on the camera displayed in the main window from the pop-up menu of 
the button (right-click). These are all system audio files that are recorded on the 
camera by the user or sound files that have been loaded in the camera. MxEasy 
uses the sound specified for the particular camera.

•	 Volume Up: Click this button to increase the speaker volume on the computer run-
ning MxEasy.

•	 Volume Down: Click this button to decrease the speaker volume on the computer 
running MxEasy.

For additional information on the audio functions of the MOBOTIX camera, see the sections 
Microphone and Speaker and Sound on Event in the Software Manual, the ExtIO and CamIO User 
Manuals and the manuals of the individual MOBOTIX camera models.
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For more information on the signal inputs and outputs of MOBOTIX cameras, see the 
section Signal Output, in the Software Manual, the ExtIO and CamIO User Manuals and 
the manuals of the individual MOBOTIX camera models.

4.4	 Adjusting Additional Image and Exposure Settings

This button gives you access to functions that allow you to set individual image settings 
such as Saturation, Brightness, Backlight or Sharpness. You can also control the exposure 
of the images using this button:

•	 Saturation: This function increases or decreases the saturation of an image. When 
you increase this value, the image becomes more colorful.

•	 Brightness: This setting allows you to adjust the image brightness. Make sure that 
the exposure windows are being used effectively before you make any adjustments.

•	 Backlight: This setting improves the display of a camera image that contain over-
exposed or underexposed areas. A typical example of this is a room that is illuminated 
only by daylight from the windows. Objects located around the edges are displayed 
too dark and with too little contrast. Increasing the value will increase overall illumi-
nation to properly display the dark areas in the image. This setting is particularly 
useful for high-contrast (color) night images.

•	 Sharpness: This setting allows you to display sharper camera images. Make sure 
not to set the sharpness too high since doing so may result in poor image quality 
(for example, for high-contrast and finely detailed images).

•	 Default Settings: Click this button to restore the default values for all settings (with 
the exception of exposure windows).

•	 Exposure Window: The MOBOTIX camera sets the exposure window to ensure the 
proper exposure/brightness for the live camera image. You can select a predefined 
set of exposure windows from the pop-up menu of this button. The corresponding 
window will then be displayed in the camera’s image and you can check the mod-
ified exposure control directly in the live image. You can specify whether or not the 
exposure window will be visible in the camera image (green box) using the Show 
Exposure Windows option.

Notes On Predefined Exposure Windows

The content of the predefined exposure windows affects the exposure of the camera. It affects 
the exposure time, among other factors, and determines the overall quality of the image.

The predefined and custom exposure windows are defined as “global” for the full image 
displayed by the image sensor. This means that the PTZ commands do not affect the 
content of the exposure windows and therefore have no effect on the exposure. If an 
image contains dark areas and overexposed areas, performing PTZ commands does not 
change the appearance of these areas. For example, if you zoom into an overexposed 
area, it remains over exposed. The PTZ commands do not modify any part of the image.
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The predefined and custom exposure windows are particularly suited for use with full 
image recording because the recorded full image of MOBOTIX cameras is not affected 
by PTZ commands.

If the camera is used primarily as a live camera, meaning that it must display high qual-
ity images even when PTZ commands are used, we recommend using the Automatic 
Exposure (PTZ) setting. With this setting, the current visible image section is used as the 
exposure window. As long as no digital zoom is performed in the camera, this area is 
identical to the full image displayed by the image sensor. When you perform a digital zoom, 
the visible area becomes smaller than the full image. This setting optimizes the exposure 
of the live image, even when you are performing PTZ commands.

Caution

With the Automatic Exposure (PTZ) setting, images recorded using full image record-
ing are affected by the PTZ commands – whenever the PTZ commands affect the 
exposure of the image.

Defining Custom Exposure Windows

The Custom option (from the pop-up menu of the button) allows you to create and edit 
individual exposure windows using your mouse.

•	 Creating exposure windows: To create a new exposure window, use your mouse 
to draw a box inside the camera image in the main window (see figure).

•	 Moving Exposure Windows: To move a window, drag and drop it to the location 
you want with your mouse. A hand cursor appears automatically when the mouse 
pointer hovers over a window.

•	 Modifying exposure windows: Drag the edge of the window using your mouse to 
increase or decrease the size of a window. A resize cursor appears automatically 
when the mouse pointer hovers over the edge of the window.

•	 Deleting exposure windows: To delete a window, click the X button in the upper 
right-hand corner of the window or press the Delete key on your keyboard.
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Defining Exclusion Windows

Exclusion windows are used to remove sources 
of light within exposure windows from exposure 
control. In the example to the right, the exclusion 
window excludes the lamp in the upper right corner 
from exposure control.

Hints For Defining Exclusion Windows

•	 Keep the Alt key pressed and draw a box 
with the mouse to define an exclusion window.

•	 Always define exclusion windows within exposure windows (exclusion windows 
outside of exposure windows do not have any effect).

Once you have defined the exclusion windows, you can use the same functions for chang-
ing these windows as for exposure windows (moving, resizing, deleting).

Note

•	 Just like the predefined exposure windows, the custom exposure windows are 
defined globally on the full sensor image. That is why these windows do not 
trigger any image adjustment when using vPTZ actions.

•	 Exposure and exclusion windows of Hemispheric cameras and cameras 
with activated distortion correction are shown as polygons if the visible image 
has been panned or tilted or the image has been switched from Normal to 
Full Image, for example.

4.5	 Bandwidth Management

MxEasy’s Bandwidth Management feature offers you an effective tool for optimizing the 
retrieval and display of live images from cameras in MxEasy.

Ideally, an Ethernet network will always have enough network bandwidth to transfer 
all data at “full network bandwidth” so that the live images of all cameras connected to 
MxEasy can be shown in all display windows at full resolution and full frame rate. And 
this is also the case for a wired Ethernet network. If the cameras (or the computer running 
MxEasy) are connected to the network via a wi-fi or ISDN connection or a modem, there 
will generally not be enough bandwidth.

With MxEasy’s Bandwidth Management, you can now set up the cameras to retrieve only 
the live images you need at the resolution and frame rate that MxEasy requires to properly 
display them at any given time. This means you can have the live image from the camera 
in the main window displayed at full resolution and full frame rate while the live images 
in the smaller camera windows are shown at a lower resolution and reduced frame rate. 
This is possible given that MOBOTIX cameras display both high-resolution video sequences 
and lower resolution images (“preview” images) at the same time. MxEasy is then able to 



82/132 MxEasy User Manual: Advanced Operation

© MOBOTIX AG  •  Security-Vision-Systems  •  Made in Germany

www.mobotix.com  •  sales@mobotix.com

retrieve those preview images (for more information, see the section Accessing The Live 
Image And The Event Images in the Software Manual).

If one of the cameras from a small camera window is displayed in the main window (for 
example, due to an alarm or if it has been manually set by the user), MxEasy will show 
the available preview images immediately and in real-time in the main window and then 
start to retrieve the images from the respective camera at full resolution from that point 
on. The live image in the main window will therefore appear for only brief moment at a 
lower resolution until the newly requested high-resolution image becomes available.

You can apply one of the following strategies for bandwidth management in MxEasy 
depending on how much network bandwidth is available (or on the network connec-
tion type for the MOBOTIX cameras) (under Preferences > Connections > Bandwidth 
Management; see also Section 4.8.2, “‘Connections’ Tab”):

•	 High (Fast Ethernet, 100baseT, 1000baseT, WLAN 802.11 g+n):

This setting is recommended for Ethernet networks with unlimited bandwidth (for 
example, 100baseT/100 Mbps, 1000baseT/1 Gbps, fast 802.11g/n compliant WLAN 
with good signal strength).

–	 Main window, camera windows: Both the live images from the active camera in 
the main window and the images from the cameras shown in the small camera 
windows are displayed at full quality (full resolution and full frame rate).

•	 Medium (Ethernet, 10BaseT, WLAN 802.11 g+n):

This default setting is generally recommended for wi-fi connections (802.11a/b) or 
Ethernet networks with reduced bandwidth (for example, 10baseT, Powerline adapter, 
two-wire media converter, etc.)

–	 Main window: The live images from the camera in the main window are displayed 
at full quality (full resolution and full frame rate).

–	 Camera windows: The images from the cameras in the small camera windows 
are displayed at a lower resolution and lower frame rate (four frames per second) 
using the Preview feature.

•	 Low (modem, ISDN):

This setting is recommended for modem or ISDN connections.
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–	 Main window: With the Preview feature, the camera images in this window may 
be displayed with lower resolution (VGA 640 x 480 px) and at a lower frame rate 
(up to four frames per second).

–	 Camera windows: The images from the cameras in the small camera windows 
are displayed at a lower resolution and lower frame rate (four frames per second) 
using the Preview feature.

The recording of video sequences always occurs at the resolution and frame rate set 
for the individual camera irrespective of the display quality of the live camera images.

If the MxEasy program window is minimized in the task bar or dock, all live images will 
automatically be retrieved at a low frame rate (four frames per second). This is the reason 
why the live images briefly appear at a lower resolution when you restore the program 
window.

4.6	 Network Environments: Camera Access From Different Locations

4.6.1	 Overview

MxEasy supports access to cameras in different locations – with different network settings. 
This way, for example, the cameras in a gas station can be monitored by a laptop located 
on site in the local area network (LAN) and later, they can be monitored remotely over the 
Internet using a preset DynDNS service. Each scenario requires different network connec-
tion data for the same cameras and it would be time-consuming to have to adjust the 
connection data each time you connect with the cameras. MxEasy supports the concept 
of a network “environment”.

The environment is a network area in which the access data is set for all cameras. Switching 
to a different environment automatically switches the network address data, i.e. the IP 
address, DNS name, port, SSL and proxy for all integrated cameras. Because the bandwidth 
is normally different for each network and access type, the bandwidth setting described 
in the last section is also coupled with the settings for the individual network environment.

Follow these steps to recreate the example described above:

1.	 Integrate the cameras and set up camera access to the local area network:

–	 Launch MxEasy (the Standard environment is activated).

–	 Search for the cameras and integrate them into MxEasy (using IP addresses).

–	 Change the name of environment to Gas station - local (under File > 
Environment > Edit Environments and double-click the name of the environ-
ment: Standard).

–	 Set the bandwidth to High under Tools > Preferences > Connections for a fast 
LAN connection.

2.	 Set up external camera access over the internet:

–	 Set up DynDNS on the DSL router and define ports for the individual cameras.
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–	 Create a new environment: Gas station - remote access (under 
File > Environment > Edit Environment, click the “+” button).

–	 Select Camera > Show Cameras and in the Cameras dialog, select the Gas 
Station - remote access option.

–	 Set the correct DynDNS address in the connection data of the relevant cameras (for 
each camera: right-click and select Information, then enter the DynDNS name).

–	 Set the bandwidth for access to Low under Tools > Preferences > Connections 
if your DSL connection is 1,000 kbps or slower.

Result

•	 To monitor the cameras on site at the gas station, you can access the cameras via the 
fast LAN by selecting the Gas station - local environment (under File > Environments).

•	 To monitor the cameras remotely, you can access the cameras via the slower DSL 
connection with DynDNS by selecting the Gas station - remote access environment. 
No additional settings are required.

The following section will describe the process of defining and editing the environments 
in more detail.

4.6.2	 Defining And Editing Environments

To define or edit environments, select File > Environment > Edit Environments:

In the Network Environments dialog, you can use the “+” and “-” buttons to define new 
environments and delete existing environments respectively. To rename an environment, 
select the environment in the list box: Double-click the entry or press F2 to rename the 
environment.

Note

When you create a new environment, MxEasy adopts all camera network data and 
bandwidth settings from the current environment.
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4.6.3	 Selecting An Environment And Changing The Network Data

You can select a predefined environment using the following commands:

•	 File > Environment (direct selection of environment)

•	 Camera > Camera Access (Edit MOBOTIX Camera dialog)

Adjust the network access information on the Access Data tab to the remote access 
data of the camera in the main window.
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•	 Camera > Show Cameras (Cameras dialog)

In order to edit the camera access data, you can right-click the camera and select 
Edit from the context menu. Next, enter the access data in the Edit MOBOTIX cam-
era dialog:

•	 Tools > Preferences > Connections
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When you select an environment, MxEasy activates the network connection data and 
bandwidth settings associated with this environment for all cameras. All changes you 
make to the camera addresses and the bandwidth settings after this point will be saved 
for the active environment.

4.7	 Recording Targets ‑ SD Cards And File Servers

All MOBOTIX cameras controlled by MxEasy can use different recording targets. Depending 
on the model and type of camera used, they can store the audio/video data on the (volatile) 
internal memory, on internal storage media (SD cards) or on file servers.

Newer cameras (Q22M, Q24M, D24M, M24M, all except Basic and Web models) and R 
models have factory-installed SD cards and are preconfigured for recording “out-of-the-box”.

At present, MxEasy cannot change the recording target on the attached cameras. To do 
so, you need to open the web interface of the corresponding camera in a web browser 
or use MxControlCenter.

Caution

This will not be an issue when using MxEasy to configure a MOBOTIX system with 
new cameras. If you are using MxEasy to add cameras with active connections to 
file servers, however, these connections will be closed when resetting the cameras 
to the MxEasy defaults.

In this case, file server storage needs to be re-established on these cameras using the 
appropriate access data. For additional information on this topic, see the Recording 
on External File Servers section in the Software Manual.

Storage Requirements And Life Expectancy Of MicroSD Cards

The life expectancy of a MicroSD card increases proportionally to the storage capacity, 
since the camera software will execute fewer write/delete cycles on each storage cell. 
The first delete operation will start once the card has been filled to capacity (first full cycle). 
The theoretical life expectancy of a MicroSD card with 16 GB reaches between 10 and 35 
years – depending on how it is being used.

Notes

•	 Please note that the values contained in the following tables are average values 
that may vary depending on how the camera is actually used.

•	 For more information on SD card recording, please see the Camera Manual 
of your MOBOTIX camera.
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32 GB MicroSD Card: Storage Requirements And Life Expectancy

6 fps CIF 6 fps VGA 1 fps MEGA 1 fps QXGA

M-JPEG M-JPEG MxPEG M-JPEG M-JPEG

File size single image 15 kB 45 kB - 120 kB 240 kB

Storage req. per second 90 kB 270 kB 75 kB 120 kB 240 kB

Storage req. per 24 hrs 7.8 GB 23.5 GB 6.5 GB 10.4 GB 20.8 GB

Time for one full cycle 4 days 1.3 days 4.8 days 3 days 1.5 days

Est. theor. life expectancy 60 years 20 years 73 years 46 years 23 years

4 GB MicroSD Card: Storage Requirements And Life Expectancy

6 fps CIF 6 fps VGA 1 fps MEGA 1 fps QXGA

M-JPEG M-JPEG MxPEG M-JPEG M-JPEG

File size single image 15 kB 45 kB - 120 kB 240 kB

Storage req. per second 90 kB 270 kB 75 kB 120 kB 240 kB

Storage req. per 24 hrs 7.8 GB 23.5 GB 6.5 GB 10.4 GB 20.8 GB

Time for one full cycle 12 hours 4 hours 14.4 hours 9.2 hours 4.4 hours

Est. theor. life expectancy 7.6 years 2.5 years 8.8 years 5.6 years 2.8 years

4.8	 Adjusting The Default Program Settings

Use the following menu commands to view the default program settings of MxEasy. Select 
the commands that apply to your operating system:

•	 Windows: Tools > Preferences menu command

•	 Mac OS X: MxEasy > Settings menu command

•	 Linux: Edit > Settings menu command
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4.8.1	 ‘General’ Tab

•	 Language: You can select the language of the MxEasy user interface with this option. 
Currently, the languages English and German are available. Additional languages 
are in preparation.

•	 Automatic Authentication: Determines whether or not users are automatically authen-
ticated when MxEasy is launched. MxEasy logs on to this access level automatically, 
without requiring the user to enter a password. For more information, see Section 3.9, 
“Creating Users And Passwords”).

•	 Folder for snapshots: Use this option to specify a directory or folder for saving images 
recorded with the Snapshot button. For more information, see Section 4.1, “Saving, 
Printing And Exporting”.

•	 Restore hidden messages: Click the Restore button to show any message and 
warning windows that have been specifically deactivated by the user by checking 
Don’t ask me again.

Note

MxEasy will warn you if an error occurs when recording data to a storage medium such 
as an SD card. This error message can be hidden by selecting Don’t ask me again.
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4.8.2	 ‘Connections’ Tab

•	 Proxy Server: If you connect to the Internet in your local network via a proxy server, 
then the proxy settings need to be entered in the MxEasy program settings. This is 
necessary if MxEasy needs to access the Internet for purposes such as downloading 
software updates (see Section 5.6, “Software Update”).

•	 Bypass proxy settings: If a proxy server has been entered, access to all network 
devices will occur over this server even if the device is a remote camera or a local 
network camera. This may result in slower access to the local camera or even prevent 
access entirely. You should therefore enter the IP addresses (or symbolic names) of 
all local network devices in the Bypass proxy settings field. Here, you can enter an 
address range (e.g. 192.168.*) or multiple addresses separated by semicolons 
(192.168.1.23;192.168.1.24).

•	 Network Bandwidth: This setting allows you to optimize the retrieval and display of 
the live images from the camera in MxEasy. Depending on the setting you select, 
the camera images will always be retrieved and displayed in MxEasy either at full 
resolution and full frame rate or at reduced resolution and reduced frame rate 
(Preview feature) (for more information, see Section 4.5, “Bandwidth Management”).

4.8.3	 ‘Behavior’ Tab

•	 Automatically show alarming camera in main view: If this option is enabled, the 
live image of a camera connected to MxEasy, but not visible in the main window or 
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the camera windows will automatically be shown in the main window of MxEasy in 
the event that the camera triggers an alarm. You will then be able to view the associ-
ated event sequence immediately (the View Events button). For more information, 
see Section 3.6.5, “Selecting The Alarm Sensors”.

Notes

If MxEasy is minimized and one of the cameras reports an alarm, the program 
window will be restored automatically and appear in front of all other applications.

•	 Show red flash on alarm: When this option is activated and an alarm is triggered, 
MxEasy displays a flashing red lightning bolt in the middle of the live camera images. 
This image disappears once you have acknowledged the alarm by clicking the image.

•	 Play sound on alarm: When you enable this option, MxEasy will automatically play 
back the selected alarm sound as soon as a camera triggers an alarm. The alarm 
sound will end when it is acknowledged automatically or manually by a user (by 
clicking the camera window). See Section 3.6, “Setting Up Alarms And Recordings” 
and Section 5.6, “Software Update”.

•	 Automatically acknowledge alarms after: This setting allows you to specify the time 
after which MxEasy will automatically acknowledge alarm messages from connected 
cameras. Automatic acknowledgement may also end a still active alarm sound. For 
more information, see Section 3.6.5, “Selecting The Alarm Sensors”.

•	 Camera Sequencer: You can define how long the display will last before switching 
to the image of the next camera with the sequencer interval. For more information, 
see Section 3.3.1, “Switching The Displayed Cameras”.
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5	 Advanced Features

5.1	 Camera Management

This section will show you how to add new cameras in MxEasy, how to edit, rename and 
remove cameras that are already attached to MxEasy.

5.1.1	 Adding Cameras

In order to add new MOBOTIX cameras to the MxEasy system, execute the Cameras > 
Add Cameras menu command. MxEasy now automatically finds new cameras and lists 
all cameras not yet attached in the MxEasy Wizard. To continue, please proceed as 
described in Section 3.1.1, “Searching MOBOTIX Cameras” and Section 3.1.2, “Selecting 
And Adding New Cameras”.

5.1.2	 Working With The Current Camera ‑ Renaming, Editing And Removing

The functions presented in this section always apply to the camera currently displayed 
in the MxEasy main window.

Renaming The Current Camera

Double-click on the camera name shown at the left of the upper information bar in the 
MxEasy main window or select Camera Rename Camera from the menu, then enter a 
new name and store it.

Editing The Current Camera

Select Cameras > Edit Camera from the 
menu. Open this dialog to change the camera 
name and to enter changed access data 
(IP address, secure connection, user name 
and password). All other tabs in this dialog 
are for your information only.

This is also where you can modify the net-
work parameters of a different environment 
of the displayed camera (see Section 4.6, 

“Network Environments: Camera Access 
From Different Locations”).
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Removing The Current Camera

Caution

When removing cameras from the system, MxEasy will offer to reset the cameras 
to the state they had before they were added to MxEasy. Please note that this 
may also affect the passwords assigned in MxEasy. They will be reset and the old 
passwords will be valid again.

Select Cameras > Remove Camera from the menu. Click on Reset to reset the cameras 
to the state they had before they were added to MxEasy. When you click on OK, MxEasy 
will remove the cameras.

5.1.3	 Working With The Camera List

Select Cameras > Show Cameras from the menu to open the Camera List. This list 
contains all cameras that are reachable over the network. Cameras that are already 
controlled by MxEasy are highlighted in bold print.

In order to edit the selected cameras, you can use the following functions (executed either 
by the context menu shown here or by clicking on the corresponding button):

–	 Add: Manually adds a MOBOTIX camera, if it cannot be found since it is not on 
the local network, but can only be accessed via the Internet.

–	 Edit: Works in a similar manner as editing a camera (see the Editing The Current 
Camera section). Note that you can only use this command if you have high-
lighted one camera.

–	 Authenticate: Use this command to change the access data used by MxEasy 
for accessing one or more cameras. Note that this command does not modify 
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the access data on the cameras (see the Changing The Access Data For All 
Attached Cameras section below).

–	 Remove: This button removes the highlighted cameras from the list and from 
MxEasy (only those that had been attached before). Click on Reset to reset the 
cameras to the state they had before they were added to MxEasy. When you 
click on OK, MxEasy will remove the cameras.

–	 Information: Shows an information dialog for the highlighted camera similar to 
the Edit button described above.

–	 Change Network Configuration: This dialog allows changing the network con-
figuration of all highlighted cameras in one step (see Section 3.1.2, “Selecting 
And Adding New Cameras”).

–	 Hide Preview Image and Legend: Hides the preview image and the legend 
or shows it again.

–	 Display Still Image: Deactivates the live stream of the corresponding camera 
and shows a still image in order to reduce the bandwidth.

–	 Activate Camera Search: This button is usually activated to show that MxEasy 
automatically searches for new cameras in the background.

Renaming The Highlighted Camera

Double-click on a camera name or press F2 to change it. Press the Return key to store 
the new name. The new camera names will be applied to the corresponding cameras 
if you close the Camera List.

Changing The Access Data For All Attached Cameras

If you would like to change the access data of 
all cameras, click on the Authenticate button 
to open the dialog by the same name. Next, 
click on Camera Access and proceed as described 
in Section 5.3, “Setting Up A Global User For All 
MOBOTIX Cameras”.



95/132Camera Settings

© MOBOTIX AG  •  Security-Vision-Systems  •  Made in Germany

www.mobotix.com  •  sales@mobotix.com

5.2	 Camera Settings

5.2.1	 Overview

Many of the settings for the connected MOBOTIX cameras can be centrally managed 
using MxEasy (the Camera Options button).

Select the camera whose settings you would like to change (the Next Camera button). 
The live image from the camera you selected will be displayed as a preview image to 
help you identify the specific camera you want. 

Click Apply or OK and your settings will be sent to the selected camera or, if the To All 
Cameras checkbox is checked, to all the cameras connected to MxEasy.

Notes

No preview image will be shown if the To All Cameras option is enabled.

You may need to reboot the camera for some of the changes described here to 
take effect. If it is necessary, MxEasy will prompt you before rebooting the camera 
automatically.
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5.2.2	 Audio Settings

You can make the most important audio 
settings for the camera in this dialog.

•	 Activate microphone and sensitivity: 
The camera microphone can be activated 
or deactivated and the microphone 
sensitivity can be adjusted as required 
using the options here.

•	 Activate speaker and volume: The 
camera speaker can be activated or 
deactivated and the volume can be 
adjusted as required using this option.

For additional information, see the sections Microphone and Speaker and Sound on Event 
in the Software Manual.

5.2.3	 LED Settings

The LEDs of the MOBOTIX cameras can 
be used to signal certain functions and 
statuses. You can assign selected flashing 
patterns to particular camera actions and 
functions in this dialog.

•	 Show Recording State: You can set 
the LEDs of the MOBOTIX camera to 
blink when an event occurs and a 
recording is made with this option.

•	 Show Camera Access: The LEDs of the 
MOBOTIX camera blink whenever the 
camera is accessed, i.e., if the live image from the camera is displayed in MxEasy or 
a configuration has been changed using the Camera Options button, for example.

LED Blinking Patterns

•	 On: LED is permanently on

•	 Off: LED is permanently off

•	 Blinking: LED is off, blinking on slowly

•	 Flashing: LED off, flashing on fast

•	 Negative flashing: LED is on, flashing off
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Blinking Patterns According To Settings

Setting LEDs Color Blinking Pattern

Show Recording 
State

Alarm: 
1, 5

•	 Continuous recording: On

•	 Event recording: Neg. flashing every 3 sec.

•	 Unarmed, off: Off

•	 Armed, waiting: Flashing every 3 sec.

•	 Critical error: Blinking in sync. with Power LED

Power: 
0

•	 OK: On permanently

•	 Non-critical error: Neg. flashing every 3 sec.

•	 Critical error: Blinking

Show Camera 
Access

Alarm: 
1, 5

•	 Continuous recording: On

•	 Event recording: Neg. flashing every 3 sec.

•	 Unarmed, off: Off

•	 Armed, waiting: Flashing every 3 sec.

•	 Critical error: Blinking in sync. with Power LED

Power: 
0

•	 Always: Double flashing every 3 sec.

For more information on the LED blinking patterns of MOBOTIX cameras, see the section 
LED Signals and LED Configuration in the Software Manual and in the Camera Manual of 
the respective camera model.

5.2.4	 Connection Settings

You can also set the parameters for com-
munications with external servers in this 
dialog, for example, if you need to send 
e-mails.

•	 DNS Server: If you have MOBOTIX 
cameras connected to the network via 
a manual IP address, you can enter 
the IP address of the DNS server used 
by your network here. MxEasy will 
automatically suggest the DNS server 
that your computer is currently using 
(the Same as this computer option). A DNS server must be entered in a MOBOTIX 
camera in order for the Time Server, VoIP and E-Mail functions to work, if the respec-
tive IP addresses are not known.

Camera LEDs

M12

D12

Q22M, 
D22M, 
M22M,  
Q24M, 
D24M, 
M24M



98/132 MxEasy User Manual: Advanced Features

© MOBOTIX AG  •  Security-Vision-Systems  •  Made in Germany

www.mobotix.com  •  sales@mobotix.com

•	 Use Secure Connections (HTTPS/SSL): If necessary, you can activate encryption 
for all data transferred via HTTPS between MxEasy and the MOBOTIX cameras. We 
strongly recommend using this option for security-related applications. Note that 
SSL encryption will place a higher load on the network bandwidth.

For additional information, see the section SSL Encryption and Certificates in the Software 
Manual.

5.2.5	 Time Settings

Each MOBOTIX camera has a battery-buffered 
real-time clock that always keeps the time 
correct, even in the event of a power failure. 
However you need to make sure that all 
cameras connected to MxEasy are syn-
chronized for playback and event tracking. 
You can do this using a time server that 
synchronizes all cameras to the exact same 
time. Use this dialog to enter or select a 
time server. Note that you can also specify 
a MOBOTIX camera as a time server.

•	 Synchronize with Time Server (NTP): Select a time server from the list or enter the 
name of your preferred NTP time server. If the MOBOTIX cameras are set to auto-
matically obtain their network data via DHCP, make sure that a valid DNS server is 
also entered in the MOBOTIX cameras (the Connection tab).

•	 Synchronize with Master Camera: Alternatively, you can select one of the cameras 
connected to MxEasy as a time server.

For additional information, see the section Date and Time/Time Zones and Time Servers 
in the Software Manual.

Hint

If the cameras are connected to the Internet, you can select a time server from the 
drop-down menu. You can also enter a time server in the local network if one is 
available. If neither a time server on the Internet nor a local time server is available, 
you should specify one of the cameras connected to MxEasy as the master camera 
for the purpose of time synchronization. Doing so will at least ensure that all cameras 
remain synchronized with each other and hence allow saved video sequences to 
be played back in a synchronized manner.
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Note

The time display in the title bar of the main window will blink if the system time of 
an active camera (Live view) in the main window deviates from the system time of 
the computer by more than 15 seconds. In this case, check the computer to see if it 
is also synchronized with a time server. Try to set up the same time server for both 
the computer and the MOBOTIX cameras.

5.2.6	 VoIP Settings For Phone Calls

Using Internet telephony, you can make 
phone calls with MOBOTIX cameras. In order 
to use this feature, you need to register with 
a VoIP provider for Internet telephony (for 
example, sipgate.de). You can enter the 
access data for the registered VoIP account 
in this dialog.

•	 Use SIP telephony in only local net-
work: No SIP user data is required if 
phone calls are to be made within 
the local network only (for example, 
to softphones installed on computers).

•	 Register with SIP provider for global SIP telephony: Enter the user data that you 
received from your SIP provider upon registration into the appropriate fields (SIP 
User Name, SIP ID, SIP Password and Registry). If the MOBOTIX cameras are set to 
automatically obtain their IP addresses via DHCP, make sure that a valid DNS server 
is also entered in the MOBOTIX cameras (the Connection tab).

For additional information, see the sections Phone Call and Phone Profiles in the Software 
Manual. For detailed information on all telephony features of the MOBOTIX cameras, see 
Chapter 9 of the Software Manual.

5.2.7	 E-Mail Settings

MOBOTIX cameras can send e-mails (for 
alarm notification, for example). In order 
to use this feature, you need to provide a 
valid e-mail address. You can enter the 
access data for the account in this dialog.

•	 E-Mail data: Enter the user data of an 
e-mail account in the fields provided 
in the dialog: SMTP Server, Port (nor-
mally Port 25), Authentication (normally 
SMTP Login) and User Name and 
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Password. If the MOBOTIX cameras are set to automatically obtain their network 
data via DHCP, make sure that a valid DNS server is also entered in the MOBOTIX 
cameras (the Connection tab).

For additional information, see the sections E-Mail and E-Mail Profiles in the Software Manual.

5.2.8	 SD/USB Settings

MOBOTIX cameras can save their recorded 
audio and video data either to the inter-
nal camera memory or an external stor-
age medium. Using an external storage 
medium can substantially increase your 
storage capacity. For the storage medium, 
you can choose the integrated SD card of 
the camera or an external USB medium 
(USB stick, USB hard drive, etc.), for example. 
The basic settings and basic functions of 
this feature are found in this dialog.

•	 External USB hard drive: Select this option if you want the MOBOTIX camera to 
record data to a connected external USB hard drive directly.

•	 SD Flash Card: This option sets the MOBOTIX camera to record data to an inserted 
SD flash card.

•	 USB Stick/Flash SSD: Select this option if you want the MOBOTIX camera to record 
data to a connected USB stick or an external flash SSD directly.

•	 Others: This option is automatically activated if the MOBOTIX camera is configured 
to use a recording mode that does not support USB, SD or Flash SSD storage devices. 
MxEasy is currently unable to set up such a recording mode directly.

A yellow recording icon will appear in MxEasy in 
the lower information bar of the main window if 
one of the External USB Hard Drive, SD Flash Card 
and USB Stick/Flash SSD options is set as the record-
ing target. Hold the mouse pointer over the icon 
in the information bar to see this tool tip.
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Caution

The Enable recording on drop-down menu shows different options depending on 
the camera model you are using. Make sure that the appropriate recording device 
is connected to the MOBOTIX camera. MxEasy will display an error message if the 
recording device is improperly connected or not connected at all.

Before the recording device can be used in MxEasy, it needs to be selected and 
formatted for the MxFFS file system using the camera software (see the section 
Recording on Flash, USB and SD Storage Devices in the Software Manual). In future 
versions, MxEasy will be able to automatically select and format the recording device.

5.2.9	 Camera Information

Information on the selected camera settings of the currently active camera in the main 
window can be accessed using the Information button.

5.3	 Setting Up A Global User For All MOBOTIX Cameras

If necessary, you can set up one adminis-
trator to be used for all MOBOTIX cameras 
connected using MxEasy (the File > Authenticate 
menu command, Camera Access button). 
This will replace the default administrator 
(user name: admin, password: meinsm). 
MxEasy then accesses all connected cam-
eras using the new user name and the 
new password.

Setting up a new administrator not only provides quick and reliable protection against 
unauthorized access, it also blocks browser access to the Guest screen (Public Access; 
for more information, see the section Users, User Groups, Passwords, Supervisor Mode 
in the Software Manual.
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Caution

A password set up in MxEasy for the global access level will never be shown for 
security reasons. Make sure that you store this password in a secure place.

If no user name and password have been entered, MxEasy uses the factory defaults 
(user admin, password meinsm). This automatically enables public access to the 
Guest screen via a browser window.

If you do not want to use a camera with MxEasy and want to use it elsewhere, you 
should first remove the camera from MxEasy (the Camera > Remove Camera menu 
command) and then reset it to the status it had before it was connected to MxEasy 
(the Reset button). If you do so, any modified user names and passwords for the 
administrator will be reset.

5.4	 Customizing The User Interface

Thanks to the software architecture of MxEasy, it is possible to change various elements 
of the user interface (for example, buttons and backgrounds).

5.4.1	 MxEasy Skins

You can change the appearance of MxEasy using the Tools > Style menu command. The user 
interface can be customized to your needs by changing the *.css file and the graphics files.

Editing Skins

A MxEasy skin consists of one or more *.css files and a number of graphics files.

•	 Windows: The files for the various skins can be found in the StyleSheets subdirectory 
of the MxEasy program directory.

•	 Mac OS: The *.css files are located in the application file in MxEasy.app > Contents > 
StyleSheets, while the graphics files are located in MxEasy.app  > Contents  > 
StyleSheets > Images.
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Right-click MxEasy.app in the Finder and select Show Package Contents from the 
pop-up menu to open the directory structure.

For example, create a copy of the file MxEasy.css and change the path for the graphics 
files. To do so, use a text or CSS editor and save all *.css files without formatting (“Plain 
Text” or “Text Only”).

Caution

Make sure you create backup copies before you start editing the files and use these 
files in place of the original MxEasy files. Knowledge of *.html and *.css files is 
necessary if you would like to create or modify skins.

When editing graphics files, make sure that you do not change the pixel size (width 
and height). All graphics files should be saved as a *.png file, especially if they 
contain transparent areas.

5.4.2	 Displaying Tool Tips

If the mouse pointer hovers over a button, a detailed 
description of the respective button will shortly appear in 
MxEasy. You can switch between the detailed Tool Tips 
and the brief descriptions using the Tools > Detailed 
Tool Tips menu command.

5.5	 Custom Alarm Sounds

Adding Alarm Sounds

Any *.wav audio file can be used as an MxEasy alarm sound.

•	 Windows: The audio files for the various alarm sounds can be found in the Sounds 
subdirectory of the MxEasy program directory.

•	 Mac OS: Right-click MxEasy.app in the Finder and select Show Package Contents 
from the pop-up menu to open the directory structure. The audio files for alarm sounds 
are located within the application file (MxEasy.app > Contents > Sounds).

Copy the new audio files to the corresponding directory. The new alarm sounds will be 
available in MxEasy immediately.
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5.6	 Software Update

MxEasy Software

MxEasy can search for a new program ver-
sion automatically using the update function. 
An Internet connection is required to check 
for updates. You can adjust how often the 
program checks for updates (the MxEasy > 
Tools > Software Update menu command). 
You can also check for updates manually 
(Check now). If a new program version is 
available, it will be displayed together with 
the release notes. The update can now be 
downloaded onto your computer (Download 
Package) or installed immediately (Install 
Package). MxEasy must be restarted after 
an update has been installed.

Camera Software
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The software versions of all connected cameras can also be updated. Available updates 
will be listed there. You can select your preferred language version as either an *.mpl or 
*.zip file (Download Package) and then install it (Install Package). The updated camera 
will be restarted after installation. The following languages are available for the M12/
M22/D12/D22/Q22 camera models (English is included in every language package):

•	 en, cn:	 English/Chinese

•	 en, de:	 English/German

•	 en, es:	 English/Spanish

•	 en, fr:	 English/French

•	 en, it:	 English/Italian

•	 en, jp:	 English/Japanese

•	 en, ru:	 English/Russian

For the Q24, D24 and M24 camera models (and higher), all available languages are 
installed. You can easily install the latest version of the software for your camera.

Caution

If you connect to the Internet in your local network via a proxy server, then the proxy 
settings need to be entered correctly in the MxEasy program settings. For more 
information, see Section 4.8.1, “‘General’ Tab”.
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5.7	 Resetting The Cameras From The Privacy Mode

If you choose not to see the generated access data when activating the Privacy Mode 
(see Section 3.7, “System Shutoff ‑ Privacy Mode”), you can only deactivate this mode 
from the same computer that had been used to activate the Privacy Mode. In case of a 
serious malfunction (or total failure) of this computer, you can only activate the system by 
resetting all attached cameras to the factory default settings.

Note

You should always try to retrieve the MxEasy Backup folder from the malfunctioning 
computer and to copy this folder to the new computer. 

Resetting The Cameras To Factory Settings

•	 Disconnect the power supply for every camera that is attached to MxEasy.

•	 Restore the power supply and press the camera button for resetting to factory 
defaults, until you hear the appropriate signal (see Section “Resetting the Camera 
to Factory Defaults”, in the corresponding Camera Manual).

Once you have reset all cameras, restart MxEasy. Follow these steps to proceed:

•	 Add all cameras to the system, which had been attached MxEasy before (see 
Section 3.1.1, “Searching MOBOTIX Cameras”).

•	 Load the automatic backup in MxEasy, if this is available (see Section 4.2, “Saving 
And Restoring Settings”). If the backup of the last system start is not available any 
more, you will have to set up the cameras manually.
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Notes:
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A	 Further Information

A.1	 Components Of A MOBOTIX System

We will introduce the individual components of your MOBOTIX system in this section. You will 
also find hints about additional information about products found on the MOBOTIX website.

A.1.1	 Power Supply

The Ethernet cable supplies the MOBOTIX cameras with power. You can use either MOBOTIX 
PoE products or switches with PoE power supply in accordance with IEEE 802.3af.

MOBOTIX NPA-PoE-Set (MX-NPA-PoE-SET)

This set powers the MOBOTIX cameras or other PoE devices via the network cable. The 
integrated cross-over feature of the adapter allows connecting the camera directly to a 
computer without using a switch. The integrated LED signals the proper functioning of the 
power supply as well as the power supply’s PoE class currently available.

For more information on MOBOTIX PoE products, see www.mobotix.com under Products > 
Accessories > Power Supply.

Switches With PoE Power Supply

When purchasing switches with PoE power supply in accordance with IEEE 802.3af, make 
sure that the required number of ports is supported (in certain units, only some of the 
ports are equipped with PoE power supply).

Uninterruptible Power Supply (UPS)

An uninterruptible power supply (UPS) consists of a rechargeable battery and electronic 
components. These components ensure that the battery is correctly charged and prevent 
the connected units from being damaged as a result of voltage peaks and lows. If an 
electrical surge occurs, the voltage peaks are filtered out and in the event of low voltage, 
the UPS takes over the power supply of the connected units for as long as the power 
stored in the battery lasts.

We recommend safeguarding the network components of your MOBOTIX system (camera 
power supply, switches, routers and even file servers) using UPS units as they can ensure that 
your system will continue to operate properly, even in the case of a complete power failure.

A.1.2	 Switch

A switch connects individual network-ready units to one another and delivers data from 
the sending units to the receiving units. In larger networks, one or more switches form the 
backbone of the system over which the data is transferred to the individual computers 
and/or network devices. In a smaller network, this function is normally performed by a 
router with multiple network ports (for example, in a home network).
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A.1.3	 Router

A router is normally used to establish a connection to the Internet. Technically speak-
ing, a router transfers requests to external IP addresses of computers that are located 
outside of the local network. If a router has a sufficient number of network ports, it can 
also function as a switch.

A router performs these functions, among others, for the units joined in the network:

•	 DHCP: Using this function, individual network devices in the local network (cameras 
and computers) are automatically assigned unique IP addresses to enable com-
munication between these units.

•	 Internet Connection: The router establishes a connection to an Internet service pro-
vider (ISP) and receives a unique public IP address (an address that is recognized and 
available online). Requests sent to an external IP address (e.g. a website) are sent 
to this public address via the router and the results are sent back to the requesting 
computer. Normally, a permanent connection to the provider is established.

•	 DynDNS: Each time the Internet connection is reestablished, the ISP automatically 
assigns the router a different public IP address (for example, if the provider interrupts 
the connection overnight). In order to assign a unique, static name to these constantly 
changing IP addresses, register with a free DynDNS provider (for example,www.
dyndns.org) and create a name for your router and Internet connection (for 
example, myhomenetwork.dyndns.org).

This unique name (for example, myhomenetwork.dyndns.org) is entered into 
the router along with the registration information of the DynDNS provider (user name 
and password). Each time the router’s public IP address is reset by the provider, the 
router registers this IP address with the DynDNS provider where the address is then 
linked to your unique name.

•	 Port Forwarding: It is possible to access individual network devices (for example, 
cameras) from outside the network using this router feature. A camera is assigned 
to a port in the router. This port sends information to the internal network address 
of the camera. In conjunction with DynDNS, you can access your first camera using 
mycamera.dyndns.org:19801 as address. MxEasy configures the connected 
cameras automatically so that each camera can be used from outside the network 
as a proxy camera.

For more information on these services, see the section Directly Accessing MOBOTIX 
Cameras via the Web in the Software Manual. Section 3.1.3, “Adding Remote Cameras 
Using DynDNS”, contains more information on the DynDNS and port forwarding topics.

A.2	 How Can I Expand My MOBOTIX System?

You can expand your MOBOTIX system with the following components to adjust the 
system to suit your needs:

www.dyndns.org
www.dyndns.org
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•	 MOBOTIX ExtIO: This expansion module, which is compatible with all MOBOTIX IT 
and Secure models, can be used to set up a separate door intercom via a USB or 
Ethernet cable in addition to the camera (USB: max. 5 m/16 ft, Ethernet: max. 100 m/110 yd, 
Mx2wire: max. 500 m/550 yd). The integrated buttons act as a call button and a 
light switch, and speech is transmitted over the microphone and speakers of the 
ExtIO. A key switch can be integrated into one of the two signal inputs, for example. 
Using the key switch, the system can be manually activated and deactivated. The 
other input is used to transfer the signals of an additional sensor (for example, a 
second motion detector). The two external consumers (for example, door opener 
and light) are controlled using relays.

Further information on the MOBOTIX ExtIO is available at www.mobotix.com 
under Products > ExtIO.

•	 MOBOTIX Mx2wire: This expansion 
module allows using two-wire cabling 
to establish network connections 
with PoE power supply for MOBOTIX 
cameras and other network devices 
for distances of up to 500 m/550 yd 
(two modules required). Mx2wire 
modules can thus be used to convert existing two-wire cables (bell wires, coax 
cables, power lines, etc.) to multimedia network connections.

Further information on the MOBOTIX Mx2wire is available at www.mobotix.com 
under Products > Mx2wire.

•	 Joystick: A joystick with three axes (two axes via the control stick and one axis via 
the rotating grip) and memory buttons for frequently used camera positions simplify 
the handling of the MOBOTIX system if users need to make frequent use of zoom 
functions to access saved camera positions.

•	 Key Switch: A key switch can be connected to one of the signal inputs of the MOBOTIX 
camera or ExtIO to allow for quick activation and deactivation of your MOBOTIX system.
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Notes:
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B	 Access Rights For User Access Levels

B.1	 Button Functions

Button Button Admin Owner User Guest

Top Toolbar

Next Camera X X X X

Camera Sequencer X X X X

Camera Overview and Layouts X X X X

Full Screen X X X X

Authenticate X X X X

Player Mode X X X

Alarm Planner X

Privacy Mode X X

Operation Mode X X

Manual Alarm X X X

Left Toolbar

Microphone X X X

Speaker X X X

Volume Up X X X

Volume Down X X X

Door X X

Light X X

Sound X X
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Button Button Admin Owner User Guest

Camera Options X

Right Toolbar

Image Settings X X

Image Formats and Views X

Activate PTZ X X

PTZ Views X X X

Print X X X

Snapshot X X X

Backup Configuration X

Information X X X

B.2	 Menu Command Functions

"MxEasy" Menu (Mac OS X only) Admin Owner User Guest

About MxEasy X X X X

About Qt X X X X

Preferences X X

"File" Menu Admin Owner User Guest

Close (Mac OS X only) X X X X

Authenticate X X X X

Page Setup X X X

Print X X X

Print Preview X X X
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"File" Menu Admin Owner User Guest

Print to PDF X X X

Export Recordings X X X

Exit (Windows) X X X X

“View” Menu Admin Owner User Guest

Next Camera X X X X

Previous Camera X X X X

Camera Sequencer X X X X

Camera Overview X X X X

Camera Management X X X X

Full Screen X X X X

Maximize X X X X

“Camera” Menu Admin Owner User Guest

Show Cameras X

Edit Camera X

Camera Options X

Information X X X

Add Cameras X

Remove Camera X

Rename Camera X

Reload X X X X

Reboot X

Player Mode X X X

Operation Mode X X

Alarm Planner X

Manual Alarm X X X
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“I/O” Menu Admin Owner User Guest

Speaker X X X

Volume Up X X X

Volume Down X X X

Door X X

Light X X

Sound X X

“Image” Menu Admin Owner User Guest

Image Settings X X

Image Formats and Views X

Activate PTZ X X

PTZ Views X X X

Snapshot X X X

“Tools” Menu Admin Owner User Guest

Preferences (Windows only) X X

Style X X X X

Detailed Tool Tips X X X X

Configuration Backups X

Software Update X

“Help” Menu (Windows only) Admin Owner User Guest

About X X X X

About Qt X X X X
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C	 MOBOTIX Glossary
ActiveX	

Control element on Windows computers which may also be used in other programs (includ-
ing Windows Internet Explorer) to run special tasks. The MxPEG ActiveX control element 
allows video and audio data from MOBOTIX cameras to be displayed in other applications 
(including Internet Explorer).

Arming	
This refers to the process of activating an alarm system so that events trigger the appropriate 
alarms. Traditional alarm systems can be armed using a key switch or by entering a code on 
a keyboard. MOBOTIX cameras can be armed using a “software switch.”

Auto Grid	
Automatically generated grid used for displaying the live images from all cameras.

Bonjour	
(French for “hello”) is a technology developed by Apple based on the Zeroconf protocol, which 
is a method to automatically recognize network services on IP networks. For example, you 
can find a printer or a network camera on the local network without knowing the exact IP 
address of the device you are looking for.

CamIO	
MOBOTIX signal module that the camera uses to directly operate lamps, sirens and access 
controls, as well as external audio components (speakers and microphones).

CCTV	
Abbreviation for Closed-Circuit Television. A television system in which the analog video signal 
is transmitted to monitor within one particular environment only (for example, a building). The 
term CCTV is often used for video surveillance systems.

CF Card	
Abbreviation for Compact Flash Card. An ultra-compact, digital (random-access) memory 
medium based on flash memory modules and well-known as an image storage medium 
for digital cameras.

CIF, 2CIF, 4CIF (in accordance with PAL TV standard)	
Common Intermediate Format. Corresponds to 1/4 TV image with 288 rows and 352 pixels 
(0.1 megapixel). 2CIF (1/2 TV image) has the same small number of rows (288), but 704 pixels 
(0.2 megapixel). 4CIF corresponds to the image quality of a traditional TV image with 576 
rows and 704 pixels (0.4 megapixel).

CMOS Sensor	
Abbreviation for Complementary Metal-Oxide Semiconductor Sensor. Sensor for energy-efficient 
digitalization of image information. CMOS sensors are used as image sensors in digital cameras.

Codec	
Blend of the words coder/decoder, which denotes a process for encoding and decoding 
data. When applied to audio/video data, two codecs are required, an audio codec and a 
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video codec. Commonly used codecs are mainly concerned with compressing the data to 
save transmission bandwidth and storage capacity.

DevKit	
Camera installation kit with independent image sensors based on MOBOTIX M12 or M22 
cameras, intended for concealed installation in other devices.

DHCP	
Abbreviation for Dynamic Host Configuration Protocol. Allows a server to automatically assign 
devices in the network with the appropriate configuration (including the IP address, DNS 
server and gateway), as opposed to fixed IP addresses on the individual network devices.

DNS	
Abbreviation for Domain Name Service. Allows the domain names of servers on the Internet 
(e.g. www.mobotix.com) to be linked (“resolved”) to their corresponding IP addresses 
(e.g. 212.89.150.84).

Dome Camera	
Most often refers to cameras with a round and compact design. The lens can be freely 
positioned and is protected by a transparent dome-shaped plastic housing.

DSL	
Abbreviation for Digital Subscriber Line. Denotes a fast Internet connection capable of provid-
ing bandwidth of up to 16 Mbps for a typical household.

DualDome	
Dome camera with two lenses and image sensors such as the MOBOTIX D12D. These lenses 
can deliver wide-angle and telephoto images independently of one another.

DVR	
Abbreviation for Digital Video Recorder.

DynDNS	
Abbreviation for Dynamic DNS (or DDNS, Dynamic Domain Name Service). Similar to DNS, this 
links domain names (e.g. mydomain.com) with IP addresses, whereby the IP addresses 
may change at any time. This service provides a convenient method to access your MOBOTIX 
cameras from home or work if the camera internet connection is not through a router which 
assigns a fixed IP address, but instead over a DSL connection with a dynamically assigned IP 
address from the provider. A well-known provider of this (free) service is www.dyndns.org.

Ethernet	
The most common technology for communication within a wired network. It facilitates data 
exchange between all devices (computers, printers, IP cameras, etc.) connected to a local 
area network (LAN).

Events	
An event refers to a situation when something happens or changes. In terms of video surveillance, 
this means a change in the status of an area that is being monitored. This can be movement 
of a person, a change in brightness, a drop in ambient temperature, the detection of a noise 
via a microphone, an electrical signal at a signal input, the manual operation of a button, etc.
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ExtIO	
MOBOTIX signal module that the camera uses to directly operate lamps, sirens and door 
openers as well as external audio components (speakers and microphones).

FixDome	
Camera without moving parts in a dome-shaped housing.

Flash Memory	  
See CF Card.

fps	
Abbreviation for frames per second. See Frame Rate.

Frame Rate	
The frame rate specifies how many frames per second (fps) are generated and sent by the 
camera. The human eye perceives movement as a smooth video sequence when more than 
14 images per second are produced.

HDTV	
Abbreviation for High Definition TV.

HiRes	
Abbreviation for High Resolution. Refers to high-resolution images (above 1 megapixel).

Image Compression	
Image compression reduces the file size of an image. This is particularly important when 
transferring and saving files.

Image Processing	
Digital image processing. The goal is to correct errors made during image generation (caused 
by overexposure, underexposure, blurring, weak contrast, image noise, etc.) in order to 
create a “better” image.

IP Network	
Data network based on the Internet protocol (TCP/IP).

IP Telephone	  
See VoIP.

JPEG	
Abbreviation for Joint Photographic Experts Group, responsible for the development of the 
JPEG standard method for image compression. JPEG is the most common lossy image format 
for photos on the Internet. Loss in image quality is barely noticeable at compression rates 
between 99% and 60%.

Latency	
Time interval elapsed between when an image is captured by a camera and when that same 
image is displayed on the monitor.

Layout	
Describes the layout of video sources on a screen site of the MxControlCenter. When display-
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ing the images from network cameras, the layout determines the positions and resolutions 
of the images displayed on the monitor. In addition to the actual video images, you can also 
incorporate graphic elements such as the location of the cameras, etc.

LED	
Abbreviation for Light Emitting Diode. An electronic semiconductor component, built in to 
MOBOTIX cameras and add-on modules, which emits light when current flows through the 
component in the correct direction.

Linux	
Free and open source operating system; serves as the operating system for all MOBOTIX cameras.

Megapixel	
Images that are 1 million pixels. Larger formats of images can be displayed as a multiple of 
this, for example, 3 Megapixel is equal to 3 million pixels.

MonoDome	
Dome camera with one lens.

Motion Detection	
Action of sensing a movement within a particular area. MOBOTIX cameras use algorithmic 
methods to detect changes from image to image in predefined areas, while taking into account 
preset conditions. If a camera detects a movement, it signals an event and triggers an alarm.

Motion JPEG, or M-JPEG,	
is a video compression method where each individual image is compressed separately as a 
JPEG image. Unlike MPEG, the quality of M-JPEG recordings is not dependent on movement 
within the image.

MPEG	
Motion Pictures Expert Group. Standard for compressing and saving image and video data, 
resulting in quality loss. Originally created for playing entertainment content on PCs, MPEG 
concentrates on displaying still image material and compromises the quality of moving image 
material in order to increase the transmission speed.

MxControlCenter	
MOBOTIX video management software for professional control of mid-sized and large camera 
networks.

MxEasy	
MOBOTIX video management software for small and compact camera networks of up to 
16 cameras.

MxPEG	
MOBOTIX-developed protocol for compression and storage of image and video data with 
minimal network load and high image quality. The MxPEG ActiveX control component allows 
video and audio data from MOBOTIX cameras to be displayed in other applications (includ-
ing Internet Explorer). To date, MxPEG remains the ONLY protocol specifically designed for 
security applications
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NAS	
Abbreviation for Network Attached Storage. A storage system connected via an Ethernet cable. 
All network devices (cameras) have access to this storage system.

Network	
Group of computers that are connected via various cables and share access to data and 
devices such as printers and network cameras.

PIR	
Passive Infrared Sensor for motion detection.

PoE	
Power over Ethernet. A technology for supplying network-ready devices (such as network 
cameras) with power via the Ethernet data cable.

PTZ	
Abbreviation for Pan/Tilt/Zoom. Refers to the movement of a video camera to the left and 
right, up and down, and to the camera’s ability to enlarge an image.

Quad Display	
Layout in which the images from four cameras are displayed in one window.

Resolution	
Indicates the number of pixels used to produce an image. The more pixels an image has, 
the greater the detail when the image is enlarged. The resolution is expressed as either the 
number of pixel columns times pixel rows, or as a total number of pixels. A VGA image has 
640 columns and 480 rows (640 x 480 pixels), which equals 307,200 pixels, or approximately 
0.3 megapixel.

RoHS	
This abbreviation stands for the Restriction of Hazardous Substances Directive and refers to EC 
Directive 2002/95/EC, which prohibits the use of certain hazardous substances when manu-
facturing products and components. The goal of this directive is to prevent these substances 
from harming the environment when the products are disposed of later.

Router	
Network device that connects multiple networks with one another. The router creates the 
physical connection between the devices in different networks (like a hub), analyzes the 
relevant data packets and forwards ("routes") these packets to the correct target network.

SD Card / MicroSD card	
SD Memory Card (Secure Digital Memory Card). A digital storage medium based on flash 
storage modules such as USB sticks.

Sequencer	
Feature that automatically switches the camera displayed in the main window after a specific 
time delay.

SIP	
Session Initiation Protocol. Network protocol for setting up, controlling and terminating a 
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communication connection via a computer network. SIP is frequently used in conjunction 
with IP telephony.

Signal Input/Signal Output	
Coupling an alarm triggering device (for example a fire alarm system or a network camera) 
to a control center or another type of transmitter (for example, a telephone or IP network). 
A typical signal input/output scenario in video surveillance progresses as follows: an event 
triggers an alarm that then displays, for example the video image from the network camera 
that triggered the alarm on the monitor at a control center.

Snapshot	
Photograph of a situation created spontaneously and directly with a mouse click or other 
such event directed by the user.

Switch	
Hardware used to connect multiple network devices (computers, cameras, printers, etc.) within 
a network. A PoE switch can also supply the cameras with power over an Ethernet cable.

UPS	
Uninterruptible Power Supply. Refers to devices that continue to supply power in the event of 
a sudden power failure. These devices usually operate using a battery. UPS is installed on the 
power lines of devices and systems in order to protect them in the event of a power failure.

Video Search	
Monitoring of recordings, searching for a particular event.

VoIP	
Voice over Internet Protocol. Telephony using computer networks.

Wizard	
Refers to a software component that helps the user install or set up a particular program 
and that guides the user through the configuration process by means of simple questions.

WLAN	
Wireless Local Area Network. Used to provide Internet connections without the need for cables.
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